Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional
Ver. 3.10
Instruction Manual

Content of this Instruction Manual
DPP is used for Digital Photo Professional.

» indicates the selection procedure of the menu.

Example: [Digital Photo Professional] menu »
[Quit Digital Photo Professional].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

**indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

0
@ : Marks information that should be read

N1/
/T

before use.

Marks additional information you may find
helpful.

Marks tips for using the software skillfully.

Switching Between Pages

Click on arrows on the bottom right of the screen.

@ : next page

€D : previous page

: return to a page you had previously
displayed

Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the “Shortcut Key List” in the Help for a
list of shortcut keys which are helpful for quick
operation.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image
Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trimming and adjusting the angle of an
image

Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

(0 1] Mac OS X 10.5t0 10.6

Computer | Macintosh with one of the above OS installed
CPU~ Intel processor

RAM Minimum 1GB

Display Resolution : 1024 x 768 or more

Colors : Thousands or more

* Core2 Duo or higher is recommended

This software program is not compatible with UFS (UNIX File System)
formatted disks.

Supported Images

This software supports the following image types.

Image type Extension
RAW images*! shot with EOS DIGITAL
cameras, excluding EOS DCS1 and .CR2
RAW images | EOS DCS3 .TIF
RAW images*2 shot with PowerShot .CRW
cameras
JPEG images EX|f2.2, 2.21 or 2.3-compatible JPEG JPG, .JPEG
images
TIFF images | Exif-compatible TIFF images .TIF, .TIFF

*1

*2

Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon’s web site.

* Only models where Digital Photo Professional is listed in the “Data
Type” item in the “Specifications” section near the end of the
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

 Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.
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Downloading Images to Your Computer Erase dust shot with the image - p.69, p.71
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computer ' Auto correct RAW images with the Auto Lighting Optimizer =» p.61 a Glance
Download images using a card reader =p9 Adijust brightness of shadows/highlights - p.57
— . Reduce image noise - p.62 . Bi:zit? .
Viewing and Checking RAW Images Correct lens aberration = p.63 Skt
Quickly enlarge parts of an image =>p.11 Use a Picture Style file - p.59
Sort images (check marks, rating) =»p.18, p.19 Edit efficiently - p.34 Advanced
. . . ’ Operation
Display an image shot simultaneously as a RAW - p.22 Edit an image while comparing the image before and
image and JPEG image as a single image after adjustment = p.53
Display the images in the thumbnail list display at high ; Nl i Advanced
resolution - p.23 Synchronize multiple images - p.54 Image Editing
L . . Display an area beyond the set range as a warning and Printing
Check shooting information such as the shooting date =» p.10, p.23 indicator (Highlight/Shadow warning) =¥ p.55
L. . . Restore an adjusted image to its condition at the time - D43 Processing
Editing RAW Images (Adjusting) of shooting P- La;sf!m:ggsers
Adjust brightness/darkness = p.12, p.26 L —
Use automatic adjustment - p.33 Printing Editing
Change the Picture Style = p.26 Print well on a Canon printer =» p.43, p.76, p.77 JITEG/TIFF
Sharpen the modulation and contrast of colors . . mages
(contrast) - p.29 \Ilzvilg:]ftrj)l:)i/n:&pgroduce the color of the subject - p.43,p76, p.77 —
Make skin tone look healthier (color tone) =>p.29 Print with the shooting information - p.74 S
Make the image colors more vivid (color saturation) = p.29 Print a thumbnail list of images -p75
,'leke an Image stharp i(shar;l)ness) wral < p3 Approximate the color seen on screen with your =082
just an image to make color tone more natura rinting results -
(white balance) = p.27 g J Index
Change an image to black-and-white or sepia tones Conversion of Images e
(monochrome) = p.30
. . . ) Convert a RAW image to a JPEG image - p.42, p.88
Trim an image and adjust the angle of an image = p.38 Edit in Photosh > 073, 0.89 @ @
it in Photosho .73, p.
Specify an aspect ratio that matches the size of the - .38 P _ P P
paper on which an image is to be printed P Perform batch processing = p.88 @‘
Edit (adjust) a JPEG image =>p.92 —
‘ % “'C; y .;;\Z “, > 7, ,‘ 4




1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Click the Dock icon.

Digital Photo Professional

DPP starts up and the main window ([Folder] window) appears.

v

Main window ([Folder] window)

& Dig! Bookmark Label Adjustment Tools Window Help

»»»»»»»

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

[Folder] window

nnnnnnn
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”

from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the

main window.
When creating a folder, refer to p.50.

808

[IH

Folder Collection{0)
v 2} MacOosx
P |4 Applications
[__,' Temporary ltems
¥ [ Users
v @ canon
- [@F Desktop
» |1 Documents
» [ Library
= Movies

P |4 Sites
» [7 Shared

Digit.

Start up EOS Utility.
Select the [Tools] menu » [Start EOS Utility].

start Quick check tool HF

Start EOS Utility CHE

EOS Utility starts up.
EOS Utility

8enn EOS Utility

Control Camera Accessories

Starts to download images
Lets you select and download images

Camera settings/Remote shooting

“ Monitor Folder
o,y
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Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF
electronic manual).

Accessories

@ Starts to download images
3

'ﬁl Lets you select and download images
e

l@ Camera settings /Remote shooting
’ Monitor Folder
-

Downloading of images begins.
The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

5@/5 Advantages of using EOS Ultility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window
(p.6, p.36).
When EOS Utility has been started up from DPP, you cannot use
the following functions.
* Quick check window view (p.16)
* Trimming and adjusting the angle of an image (p.38, p.100)
* Dust erasure processing (copy stamp function)
(p.69 to p.73, p.103 to p.107)
* Batch change file names (rename function) (p.90)
* Printing with shooting information (p.74)
* Printing a thumbnail list (contact sheet printing) (p.75)
* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.43, p.46)
* Transferring images to Photoshop (p.73)
* Batch saving images (batch processing) (p.88)
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Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open a removable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

en0 Digital Photo P|

!
i

Folder Collection(0)
¥ 2 MacOsX
» | A Applications
|- Temporary Items

¥ | & Users
v @ canon

P =) Pictures
» [& Public
» [ sites
» |7 Shared
¥ . EOS_DIGITAL
» [ DCIM

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.

In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

8086 Digital Photo Profession

il

D (E e

Folder Collection(0)

¥ I Macosx
> [& Applications
[3 Temporary items
¥ L& Users
v @ canon
v [@F Desktop
¥ [
[ 102cANON ®
» | Documents IMG_0001.CR2
» | & Library
® Movies

ie

& Music
» [ Pictures

Images in the folder are displayed in the main window of DPP.

—Z@/E Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the

folder are displayed in DPP and you can check the shot images.

5

Copying to your computer may take time when there is a large
number of shot images saved in the memory card.

For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

o Rotate selected image
Main window ‘

uuuuuuuuuuuuu

Adobe RGB / Adobe RGS High qualiy __Recipe data: Yes Number o images: 15 Number of seected images: || QuYK. %

Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP. Please use “ImageBrowser”, which is
compatible with EOS DIGITAL movie files.
If the message [Insufficient memory.] appears, there are too many
images in one folder. Decrease the number of images in one
folder such as by dividing them into smaller folders.

@ When aspect ratio information is attached to the shot image with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D,
EOS 60D or EOS 600D, the image is displayed as a trimmed image
(p-38, p.100).
For a list of main window functions, refer to p.112.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

View
Edit in Edit image window -
View collections NHG

v Tab

v Folder view

+ Toolbar
Tool palette ®T
Large thumbnail #1

+ Medium thumbnail #2
Small thumbnail #3
Thumbnail with information 34
Sort »

The display changes to the selected item.
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Enlarge and View an Image in the Edit Window

Double-click

The edit window appears.

Edit window '

Tool palette

o0

BB 15 Digial Photo Professional - [ MacOSK/ Users canon/Pictures Photo 0k 30 xx MG, 0001 CR2 |

It may take time for the image to redraw itself.
Click the [@®] in the upper left of the edit window to close the edit
window.

|§| By selecting the [View] menu P [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size
has been changed and then been converted and saved (p.42, p.121),
images for which you selected an effect other than [Shot settings] as
correction of fisheye lens distortion aberration, or images which have
had settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.

For a list of edit window functions, refer to p.115.

Enlarging and Viewing a Specific Area

Double-click the area you want to enlarge.

Pt rofesons eGP Frta o o WG 000 R T

[ —

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view.

To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.80).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [ % ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette

——{ RAW | RGE | NR/Lens/ALO

a— .
|En’ghtness adjustment l| =0 Reverts the |mage to
f? o the original settings
|Whjle balance adjustment [ B ;| I:_)rag the Sl|der Ieft or
— — right
|#] Register...
Shot settings | 3] [ Tune..
Picture Style = |
standard 1) ( Browse.. )

S 1 T e e R T By it

Contrast: 10— —
Highlight: (D) T ——
Shadow: 10T —
1 Linear
Color tone: [ Teme—
Color saturation: 1 —_e—
Unsharp mask ]
Strength: {0 9____-
Fineness: {0y 6—'
Threshold: (0 —

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALO] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.85).

@ For a list of tool palette functions, refer to p.116.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window HEW
([ save %S
Save As... i35
Convert and save... ®D
Page setup... i+ ¥P
Print... 3P
Print with detailed setting... {r3D
Contact Sheet Prints... ~ 3P
Plug-in printing 4
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.88)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HW
Save #S5
Save As... {35
Convert and save... #D
Page setup... {i 3P
[ Print... %P )
Print with detailed setting... 43D
Contact Sheet Prints... “~ 3P
Plug-in printing >
Info... |

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-I\@/E To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.49)

Print using a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.76)

Print with shooting information (p.74)

Printing a thumbnail list (contact sheet printing) (p.75)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo

Professional].

Digital Photo Professional

About Digital Photo Professional
Preferences...
Service

Hide Digital Photo Professional

Hide Others H#H

( Quit Digital Photo Professional

DPP quits.

@ A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cccccc.oco... 16
Sorting IMages.......coooeeeiiiiiiieee e 18
Attaching Check Marks..........cccccceeeeeiiiicciiiiiieeeee. 18
Setting Ratings ........vvvveeiiieiiiiiiiiieeee e, 18
Sorting Images in the Main Window .......................... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window ...................... 20
Arranging by TYPE ..o 20
Arranging Freely ... 21
Displaying a RAW Image and JPEG Image as a Single
=T =SS PPPPPRRR 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information.................ccccccuuvvnnneen... 23
Editingan Image ........ccooovviiiiii e 25
About the RAW Tool Palette...........ccccoovvvvvveeeeineennn, 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightness.........ccccceeeiiiiiiiiiiiiiieeeeeee e 26
Changing a Picture Style ..........cccccccooeoiiiiiiiiiiiiiiee. 26
Picture Style File..........ccoooiiieieeee 27
Adjusting Color Tone by Changing White Balance.... 27
Adjusting Color Tone Using Click White Balance...... 28
Adjusting Contrast ..........ccccieeiiiiiiiiie e 29
Changing Color Tone and Color Saturation............... 29
Adjusting Monochrome ...........ccccccveeiiciiieeeeece. 30
Adjusting Image Sharpness.........cccccoecceeeeeeiiiiienennnn 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
CUIrVe ASSIST) ... 33

Editing Efficiently ..., 34
Editing in the Edit Image Window............cccccovveeeeenen... 34
Changing the Thumbnail Display Position to a Horizontal
POSItION......uiiiiiiiiiee e 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing ReSults...........cccovvviiiiiiiiiiiiiiee e 41
Saving Editing Contents to a RAW Image................... 41
Saving as a JPEG or TIFF Image........ccccccveeeeeeeeeennne. 42

Re-Editingan Image........cccccoo i, 43

Printing an Image ..., 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ........................ 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint............cccccccccooos 46
Printing Photographs with a Printer other than Canon
Inkjet Printers...........oooioiiii e 49

Organizing IMages ........cceeeeeiieiiiieeeeeeecee e 49
Deleting an Unwanted Image ..............cccccvivieeennnnennn. 49
Creating a Folder for Saving Images...........ccccvvvuueeee 50
MOVING IMAgES ......eveiiieiiiiiiie e 50
Moving Images in Folders ..............ccc 51
Registering Frequent-Use Folders (Bookmark
Registration) ..........ccccoooiiiiii e 51

Organizing Bookmarks ...........cccccccoeeeeiiciviveeeneen... 51
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into five groups.

Display the quick check window.
Click the [Quick check] button.

Digital Photo Professional - [ MacOSX /Users/canon /Pid

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

"

2.

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

Double-click

The area you double-clicked is enlarged to 50% view.

To change the display position, drag on the image.
Double-click again to revert to the full view.
To quit, click the [OK] button.

@ When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size
changed and then been converted and saved (p.42, p.121), or which
have had settings specified during RAW processing on the camera
for distortion correction and chromatic aberration correction.
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> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <38> + <—>or
<3> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

@ The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.80).

For a list of quick check window functions, refer to p.119.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [v] to [«].

Check mark
[ Clear ]
e s Click

The selected check mark appears in the upper left of the window.

Check mark

2/15 IMG_0002.CR2 [3456 x 2304]

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the
<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [ - ].

Rating
[ : .Réj.e.[t. ; ]

(s » 2 & #) Click (changes to [ % ] after
clicking [ =1])

The rating is set and an icon corresponding to the selected [# ]
appears in the upper left of the window.

(Window shown with a rating of three [ ])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Il?ating icon

2/15 IMG_0002.CR2 [3456 x 2304]

| 50% view Full screen

Check mark

To cancel the rating, click the same [ ] as when the setting was
made on the right of the window.

@ As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.

@ You can also set ratings (including [Reject] setting) from the menu
that appears by clicking on an image in the main window while
holding down the <control> key.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E¥] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [] to [&] in the toolbar.

Click

frame.

S

® 9 & 2

chec!

atate right

— Check mark

; IMG_0001 CRZ w3 MG_O0D2CRZ ~ IMC_O003CRZ
. : - 63 |

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [|] in the toolbar.

Click (changes to [E3]
after clicking [H])

- Select

" IMG_O002.CRZ he 2 m' " IMG_00D.CRZ

The rating is set and an icon corresponding to the selected [Ei]
appears in the image frame.
(Window shown with a rating of three [E4] as an example)

& Rating icon

- [C] -
| mMeomorcR o |

To cancel the rating, click the same [E] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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ALy

=@> To select multiple images in the main window

Click on desired images while holding down the < 38> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

5\@/5 To display more thumbnails in the main window

You can display a large number of images by setting the size of
thumbnail images to small (p.10). Then, by selecting the [View] menu »
[Rating] and removing check marks so that ratings no longer appear in
the image frame, you can display still more thumbnail images in the main
window.

@ The [Label] menu can also be used to attach check marks and set
ratings.
By selecting the [Edit] menu » [Check mark] or [Rating] » image
selection criteria, you can refine criteria for selecting
checkmarked or rated images.
You can display and change the rating settings set in DPP with
other bundled software and on the EOS 60D, EOS 600D, or
EOS 1100D camera.
« EOS Utility version 2.9 or later:
Ratings set in DPP are displayed on image thumbnails in the
viewer window. However, [Reject] is not displayed and you
cannot change rating settings.
* ImageBrowser version 6.6 or later:
Ratings set in DPP are displayed in the main window (Preview

Mode) and viewer window. You can also change rating settings.

* On an EOS 60D, EOS 600D, or EOS 1100D camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating
settings set for still images in ImageBrowser version 6.6 or later
and on an EOS 60D, EOS 600D, or EOS 1100D camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

View collections NHEC
v Tab
v Folder view
v Toolbar
Tool palette ®T
v Rating
Large thumbnail 1
¥ Medium thumbnail 2
Small thumbnail 33
Thumbnail with information 34

0 Rating : Ascending order
Rating : Descending order

v File name
Shooting Date/Time
RAW priority

Check mark1l
Check mark2
Check mark3
Check mark4
Check mark5

The images are arranged in the order according to the selected
item.
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Sort item

Rating: ascending
order

Rating: descending
order

File name

Shooting Date/Time

RAW priority

Check mark1 -
Check mark5

Description

Sorted in order of fewest [ ¥ ].

Sorted in order of most [« ].

Images are sorted by file name in alphanumeric
order (0to 9 = Ato 2).

Images are sorted by shooting date and time
from the earliest.

Images are sorted in the following order: RAW
images - JPEG images — TIFF images.

Images with check marks take priority and are
sorted in number order.

-:\@/3 Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as

follows:

Check mark1 selected: 122->3-4-5
Check mark2 selected: 2-3->4->5->1
Check mark3 selected: 3»4->5->1->2
Check mark4 selected: 4-5->1-2-3
Check mark5 selected: 5-1-22->3->4

Arranging Freely

Drag and drop the image to the desired location.

@ oig = 4 Wed 1048AM @

T T i v T s e )
The image moves to the desired location.
You can also select multiple images (p.20) and move them.
The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.
Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

Ny

5@5 Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p-80).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.90).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences

General settings l View settings l Tool palette Color management
—

Grid pitch
64 Pixels(8-256)

Locking selected image

E Images opened in Edit window remain selected in main window

Magnification in Edit window

%) Fit to window O s0% O 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

™ 50% ) 100% ) 200%

d IPFC
E Display only CR2 images for CR2 and JPEG files of the same name J

Sort order in main window
E Retain sort order

Highlight/shadow warning

Highlight 255 (92-255) [
Sharlow 0l (-4 I
Quick check tool display
™ s50% ) 100% (moiré reduction off)
( Cancel ) E Ok ‘

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(XXD] mark (p.114).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

—Z@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

* Moving or copying an image (p.50)

» Checkmarks (p.18, p.19)

* Rating (p.18, p.19)

* Rotating an image (p.112, p.119, p.120)

+ Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ 23] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.113).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window #0
Open in Edit window (enlarged)
Close all
Open window 36N
Close windo W
Save 35
ye Ac {L 35S
' Add thumbnail to image and save 3T ]
Convert and save... #D
Batch process... ¥*B
Create new folder... 13N
Page setup... {+3EP
Print... *HP
Print with detailed setting... {+3#D
Contact Sheet Prints... ~¥P
Plug-in printing >
Add to collection #G
Remave from collection {+3#G

E\@/E The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to add.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.
800

Folder Collection(0)
v = ENG
P | & Applications
>[4 Developer
» [ Phoro 1

The image information window appears (p.24).
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Select a tab sheet and check information.

[Shooting Information] tab sheet

[Metadata] tab sheet

800 _ IMG_D001.CR2

{ Shooting Information | M

| Item Value
FlleName _________|IMG 0001.CR2
| Camera Model Canon EOQS XXXX

| Firmware Firmware Version X.X.X
| Shooting Date/Time O O XX

| Owner's Name

| Shooting Mode Shutter-Pricrity AE

| Tv( Shutter Speed ) 1/1600

| Av({ Aperture Value ) 8.0

| Metering Mode Evaluative Metering

| Exposure Compensation 0

| 150 Speed 400

| Auto |50 Speed OFF

| Lens EF70-200mm f/4L USM
| Focal Length 188.0mm

| Image Size 000000

| Image Quality RAW

| Flash off

| FE lock OFF

| White Balance Mode Auto

| AF Mode Manual focusing
| Picture Style Landscape

| Sharpness 4

| Contrast o

| Saturation o

| Color tone o

| Color Space sRGB

| Long exposure noise red... 0:0ff

| High 150 speed neise re...  0:5tandard

| Highlight tone prierity 0:Disable

| Auto Lighting Optimizer 3:Disable

| Peripheral illumination c... ' Disable

| Dust Delete Data No

| File Size XXXXXKB 5
| Drive Mode Continuous shooting
| Live View Shooting OFF

| Date/Time{UTC)

| Latitude

Lonaitude

N R

800 _ IMG_D001.CR2

| Shooting Information | Metadata }

Description

=)

[Document Title]
XXHHKANK

[Authar]
XNHHKANK

[Author Title]
XXHHKANK
[Description]
XNHHKANK
[Description Writer]
000000

[Keywords]
XNHHKANK

[Copyright Status]
HXHHKARK

[Copyright Notice]
XXHHKANK

[Copyright info URL]
XXHHKANK

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in
Photoshop CS3 or later after shooting is displayed in the
[Metadata] tab sheet. IPTC* information provides additional
comments on images, such as captions, credits and the shooting
location. The information is sorted into 5 different categories and
can be viewed by selecting [Description], [IPTC Contact], [IPTC
Image], [IPTC Content] or [IPTC Status] from the list box in the
[Metadata] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

Ay
<~
NY<

Convenient uses in the main window

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

600

Tool palette

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3£> +
<Z> keys.

@ You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
Refer to p.115 for a list of edit window functions, and p.116 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALO] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens/ALO] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool palette] button (p.112) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

——{ RAW | RGE | NR/Lens/ALO Reverts the image to
[Ansbase wlpssonnt [ L2 J——the original settings
] .
[NE A -ml Prrrrinn 0.00 Enteranumerlcal
‘White balance adjustment =) :‘ value
Ed 1 [ 23 |(Register... ]
Shot settings | :] P Tune.—

Drag the slider left or right

@ The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

¥ &

|F‘icture Style hiﬂ— Reverts the image to
: = the original settings
[ Standard I ]Y Browse... | Select

A

F—iD.ﬂ -3.0 -6.0 -40 =20 O 20 4.0

Contrast: o T@T

Highlight: T

Shadow: 0 W
| Linear

Color tone: (i .5. Vi

Color saturation: o) TET

@ Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.81).

[Auto] is only applied to images shot with the EOS 600D.

When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS 600D are included.
However, [Auto] is actually applied only to images shot with the
EOS 600D.
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Picture Style

Standard

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description
The image looks vivid.

Ordinarily, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.
The colors will look vivid, especially for blue skies,
greenery, and sunsets in nature, outdoor, and
sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.29).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function file of Picture Style. Refer to
p.59 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an

image of, for example, pale-colored flowers.

——[*RAWS| RGB | NR/Lens/ALO ——

‘Erighmess adjustment = :‘
|||-||ll||-:.<2|||-llllll- l:‘IDD

‘White balance adjustment [ o] j}
B [ Cregmer.

[_ Shot settings | :]I Tune )

Select

Reverts the image to
the original settings

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.28).

Ny

@< Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.29) to get closer to your

requirements.

@ You cannot register the adjustment results as personal white
balance (p.87) when you have selected [Shot settings] from the list

box.

@ Refer to your camera’s Instruction Manual for details on each white

balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

[ RAW | RGE = NR/Lens/ALO |
‘Erighmess adjustment = ‘
||||||||||Im||||||||||| G-DD
‘White balance adjustment - ‘
A 1 | 2 | 3 |( Register.. _
e S Click
Shot settings | v] (_ Tune... :I

Click on a point that is to be the standard for white.

000 .. Digital Photo Prfessiona! -  MacOSX Userscanon) Pictures Photxx0x 30/ MG_O00LCR2 1 OO0 5 weooocme:

Click Reverts the
The coordinates of the cursor position and the image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

@ The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast

weaker.

| Picture Style

=)

' Standard

) Browse.. )

5

Contrast:

""10.0 -3.0 6.0 -4.0

Highlight: Y
Shadow: L] 'T..eﬁ

! Linear
Color tone: o —__9-__
Color saturation: (]} —e—
" Unsharp mask f ‘]

Strength: {0) E?

Fineness: (]} ‘\:?

Threshold: ] @-—

—— Reverts the image to
the original settings

——— Drag the slider left or
right (9 steps)

A/

Displays the value of the setting

@< [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is

checkmarked, the image will become dim.

@ The Auto Lighting Optimizer (p.61) will not function when [Linear] is

checkmarked.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.30).

| Picture Style

(=]

' Standard

-¢]I" Browse... |

[

4

A

~100 -80 -6.0
Caontrast:
Highlight:
Shadow:

| Linear
Color tone:

Color saturation:

=40 =-2.0 0 2.0 4.0

o llllillll

8 e e 1

0 |||||i (]

A
(00

" Unsharp mask

)

—— Reverts the image to
the original settings

T Drag the sliders

left or right

Strength: (00 e_____
Fineness: (00 Q—‘
Threshold: {00 E;’
Displays the values of the settings
Color tone:

Color saturation:

Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones

redder.

The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

| Picture Style [ ® ]I Reverts the image to
the original settings

Monochrome | $] { Browse...

- ]

A

r\--~1I}_0 -8.0 -6.0 -40 -20 0 20 4.0

Cantrast: a ‘__‘e-._r
Highlight: [T —
Shadow: 10 T
! Linear
Filter effect: {None) BT Drag the sliders
Toning effect: {None) T 4‘ left or I'Ight
Unsharp mask 3
Strength: A d o
Fineness: 10 eﬁ
Threshald: 0]} m

Displays the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.
Yellow Blue sky is reproduced more naturally and white

clouds emerge clearly.

Blue sky becomes somewhat darker. The

Orange brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red .
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

:@3 Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image harder or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and

[Unsharp mask].

[Sharpness]:

[Unsharp mask]:
[Strength]:

[Fineness]:

[Threshold]:

Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

Adjusts the image’s sharpness more finely.

Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

Select [Sharpness] from the list box and make the

— Reverts the image to
the original settings

Select [Sharpness]

setting.
‘Picture Style [| ey W
! Standard f :! ( Browse... )
1 ~d
n A
-10.0 -8.0 -6.0 -40 -20 0 2.0 40
Contrast: it s .5. o
Highlight: 1t s .9_. el
Shadow: o st
| Linear
Color tone: AT ,6. i
Calor saturation: WG .5_ T
[ Sharpness i]‘
Sharpness: Eovsl iy
T
Drag the sl

ider left or right

Displays the value of the setting

@ The adjustment range is 0 to 10 (in 1-stop increments).
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Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make
the setting.

‘ Picture Style |3J‘

Standard f #] (_ Browse... |

s — ™

A

100 8.0 -60 40 -20 0 2.0 4@

Contrast: ) i .5. Cr

Highlight: e .@. AR

Shadow: A .$. Vi
| Linear

Color tone: Ll T@T

Color saturation: L1 5 e

| grer— \ Select [Unsharp mask]

Strength: |
Fineness: _ul
Threshald: I

Displays the values Drag the slider left or right
of the settings

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.127). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired

automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
raw [["RGB |] NR/Lens/ALOD
[FnEr e 7 |+ Jzo - Reverts the tone curve
Tone curve adjustment [ 5| to the original settings
PR R [ c | & [
o LOEn .
255 /l High
Standard
D ]
o 255
Brightness: 0 i
Contrast: ‘
Hue:
Saturation:
Sharpness:

The tone curve changes as adjusted.

¥

=Q< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

(D If you click the [(E25])] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.96).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Edit image
window

v ENG
b} | & Applications
b L'- Developer
[Z phota i

Click

The main window switches to the edit image window.

Edit the image.
Change the size
Edit image window

@& Digital Photo Professi

.........

........

aaaaaaaaaa

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

|§| By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.121), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Introduction

Double-click the area you want to enlarge.

el A

-Z\@E To display an image in an enlargement ratio other than 100% S

Click the [50% view] or [200% view] on the toolbar.

Contents at

a Glance
—_
@ You can change the way the tool palette is displayed (p.81).
You can change the enlargement ratio when you double-click Basic

—_— (p-80). Operation
f Double- With the edit image window, you can only select ima_ges from one -
click folder. To gather images from several folders for editing, refer to
“Gathering and Editing Images in the Collection Window” (p.36).

For a list of edit image window functions, refer to p.120.

Advanced
Image Editing
and Printing

—

e —— )

The area you double-clicked is enlarged to 100% (actual pixel

size). Processing

Large Numb
To change the display position, drag on the image or drag the ;sf'ﬁm:g‘e:rs

enlargement display position (p.116) of the tool palette. —
Double-click again to revert to the full view ([Fit to window]). Editin
To return to the main window, click the [Main Window] button on JPEG/TIFF

the toolbar. Images
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

& Digital Photo

mmmmmmmm

,,,,,,,,

display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window ¥0
Open in Edit window (enlarged)
Close all
Open window 36N
Close window HEW
Save 35
Save As... 1+ 365
Add thumbnail to image and save {3T
Convert and save... #D
Batch process... B
Create new folder... 3N
Page setup... {+3#P
Print... #EP
Print with detailed setting... {+ 3D
Contact Sheet Prints... ~3P
Plug-in printing [ 4
[ Add to collection #G
Remove from collection 3G

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

8006
2 (£
Folder Collection(14)
¥ =} MacOsx

A Applications

[7 Temporary Items
¥ |+ Users

v % canon

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

B 4 Wed 9:46 AM @

@ Digital Photo Professional File Edit View Bookmark Label Adjustment Tools Window Help
806 Digital Photo Professional - [Collection]

chck

Adobe RGB / Adobe RGB High quality  Recipe data: No Number of images: 7

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

¥

=@>= To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by clicking while holding down the
<control> key, and selecting [Clear collection] from the menu that
appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

@ You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after quitting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.80).

You cannot use the following functions in the [Collection] window.

« Starting of EOS Utility (p.7), or synchronizing of folders with
EOS Utility

» Batch change the file name of images (p.90)
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Trimming and Adjusting the Angle of an Image

Adjust the angle of the image as needed.
Trimming/angle adjustment window

Introduction
You can trim only the part of an image you need, or change the

composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming.

—_—

(9 1/1 IMG_0001.CR2 [3456 x 2304] c°r|Gtents at
. . a Glance
Select the image to be trimmed. Largest ]
----------------- possible
. . . . trimming .
Open the trimming/angle adjustment window. range Basic
Click the [Trimming Angle] button. Click Operation
) — Clic
Digital Photo Professional - [ MacOSX /Users/canon/Pic (I’Otate
image left Ad\gc_ed
or right in Opgi@tion
90-degree
increments) Advanced
Image Editing
— | and Printing
Drag*® (0.01-degree increments;
adjustment range: -45 to +45 degrees) P .
. . . . rocessing
The trimming/angle adjustment window appears. Large Numbers
Editing can be done once the image is displayed clearly in the Use the mouse (click A/V¥) to adjust the angle or of Images
trimming/angle adjustment window. directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees) Editing
* You cannot adjust the angle of images that exceed 9999 x 6666 J'TE%LEF
pixels in size. =
If you click [Center on Screen], you can display the trimming
range in the center of the window. Reference
When correcting lens aberrations, it is recommended to perform
[Lens aberration correction] before adjusting the angle of the
image. Index
If you click the [OK] button after adjusting only the angle of the

image, the image will be trimmed at the largest possible trimming
range.

ﬁl When aspect ratio information is attached to an image shot with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D,
EOS 60D or EOS 600D, the trimming range based on the aspect
ratio information is displayed.



Select a ratio and drag the trimming range.

8ne [¥ 1/1 IMG_0001.CR2 [3456 x 2304]

—Cancel

'A — Select a
trimming
ratio

— Drag the
trimming
range

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]:  You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.114).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.114).

* Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D, EOS
60D or EOS 600D, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 60D or EOS 600D, its trimming range cannot
be changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.122).

¥

== Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <38 > key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

© For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, refer
to p.122.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.85) can be saved as a separate file from the image
and loaded and applied to another image (p.86).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.68) and the dust
erase processing explained in Chapter 3 (p.69 to p.73) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window ¥0
Open in Edit window (enlarged)

Close all

Open window BN
Close window HrW
Save 35

Save As... ir3s

Add thumbnail to image and save { 3T
Convert and save... #D
Batch process... 3B

Create new folder... ir36N
Page setup... {r3EP

Print... 3P

Print with detailed setting... {+3¥D
Contact Sheet Prints... ~ 3P

Plug-in printing P
Add to collection G

Remove from collection {r36G

Clear collection

Delete |
Info... |

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Open in Edit window ¥0
Open in Edit window (enlarged)
Close all
Open window M
Close window HEW
Save 3ES
Save As... {385
' Convert and save... ®D l
Batch process... 3B
Create new folder... 13N
Page setup... {+ 3P
Print... 3P
Print with detailed setting... {+¥D
Contact Sheet Prints... ~HP
Plug-in printing »
Add to collection #G
Remave from collection 3G
Clear collection
Delete E: |
Info... #l

The [Convert and save] window appears.

Specify the necessary settings, and then click the
[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

Convert and save

El)*— Enter a file name
#) }——+— Select the save
destination

#) }——+|— Select an image type

Image quality et )

(Save As: DPP_001

( Where: [ Photo

File format

(Kind of file Exif-JPEG

Output setting

Output resolution 350 dpi [} Embed ICC profile

Resize setting
] Resize
Width Height Unit
3504 x 2336 pixel
{3504 pixel ) {2336 pixel )
V! Lock aspect rati

—— Click and save

[ Cancel ) Save

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

N
~

:@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@ By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.69 to p.73) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.78, p.79).

You can batch convert and save multiple images (p.88).
For a list of [Convert and save] window functions, refer to p.121.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

* Adjustment
Rotate left L
Rotate right FER
Work color space >
Tone Curve Assist - Standard
Tone Curve Assist - High

Revert to last saved settings “C3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers
(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Introduction

Select the image to be printed. In the EPP EX window, select the [File] menu »
[Preferences].
Start up EPP EX. Contents at
Select the [File] menu b [Plug-in printing] » [Print with Easy- e = a Glance

PhotoPrint EX].

MNext S5tep Basic

Open in Edit window HO Operation
Open in Edit window (enlarged)
Close all
Open window N Preferences...
Close window H#W -
Save 25 ]
Shn a3es The [Preferences] window appears.
Add thumbnail to image and save T . . . . . . Advanced
Chinae iy %D In [Print Quality], select [Quality Priority], click the Image Editing
Batch process... %8 [Option] button, and then in the dialog box that and Printing
Create new folder... o %N appears, checkmark [Print with the best quality when :
Page setup.. o %p you select [Quality Priority]]. L:,g;‘ﬁjfn'ggrs
Print... _ _ #P YoXs Fra— N of Images
Print with detailed setting... {+3ED ; - -
Contact Sheet Prints... ~HP Prin e
g-in p g i wi = i Editing
i i = i Number of copies : . Copies
Add to collection #GC SISy Rasy S is Printing om: lsy Date P ?] JI?rE%LEF
Remove from collection T®G Amount of extension of borderless printing Default —
Eesnlienbn Print Quality : [ Quality Priority _]]7— Select
Delete %@ Coin ) Quality Reference
Info... ) Priority
e
EPP EX starts up.
Index
_—
( Defaults )
Help = Cancel ) ( oK ) @ @
Click and checkmark [Print with the best quality @

when you select [Quality Priority]]



Select the [Advanced] tab, checkmark [Enable ICC
profile], and then click the [OK] button.

The [Preferences] window closes.

Specify the number of sheets to be printed, and then

click [Select Paper].
EPP EX

Specify the number of copies to printfor each image.

001.CR2 IMG_00!
A (L4]N] H_A =0E (53] ||

MG 0012.CR2
0=

.
!‘
“ @
§
| W E
of

—_—

Exif Print

[ bt ! —
1 IMG_0001.CR IMG._ 03.CR2 Mc 0004. (Rz IMG_0005.CR2 IMG_00f IMG_0007.CR2
out/Print ! ‘_H

Click to
increasethe
number of
sheets to be
printed

Select the paper type, and then click the [Layout/

Prlnt] button.

Selectthe prin

xxxxxx

Exif Print

[E—rT—
—T—

Click

Select the
paper size
and type

Specify the layout, and then click the [Print] button.

806 New Photo Print - Easy-PhotoPrint EX

Photo Print

Exif Print

Click to print
Printing begins.

Select the
layout
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet.

In the [Advanced] tab sheet, select [Enable ICC profile] in [Color
correction for printing] and try printing using the [Perceptual] setting
(p.128).

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.76).

Printing Photographs with Canon Inkjet

Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with Canon

inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):

Simple printing of RAW images

High quality printing using the color reproduction range of Adobe RGB

and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer. When using an Easy-PhotoPrint EX-compatible
inkjet printer, it is recommended that you print using Easy-PhotoPrint EX

(p.43).

Select the image to be printed.

Start up EPP.

Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint].

Open in Edit window
Open in Edit window (enlarged)
Close all

Close window

Save

Save As...

Add thumbnail to image and save

Convert and save...
Batch process...

Create new folder...

Page setup...

Print...

Print with detailed setting...
Contact Sheet Prints...

Add to collection
Remove from collection

EPP starts up.

#£0

HEW

385
{r 365
{+ 38T

#D
3B

i+ 3N

ir 3P

EP
{+36D
~3#P

#EG
{+38G

Print with Easy-PhotoPrint

3EE
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In the EPP window, select the [Easy-PhotoPrint]
menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...
 Preferences... %, )

Services [ 3

Hide Easy-PhotoPrint 3H
Hide Others C#EH
Show All

Quit Easy-PhotoPrint  3Q

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences
Cprint | Advanced |
Print Number of copies : 1 ’? Copies
Printing Order : By Date Hi
Amount of extension of Default F
borderless printing :
Print Quality : [ Quality Priority H"i]—— SeleCt
Quality
Priority
® ( Cancel ) W

Select the [Advanced] tab sheet and check

that the

EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.

Preferences

[T T
{ Print | Advanced ]

Image ptimize images automatically

EApply Rotate /Trimming to the same images in the same manner
When landscape images are rotated depending on the selected
) Rotate Left

) Rotate Right

Layout 1 Always trim when you select the layout with the margins

ESet margins to the minimum when you select the layout
with the margins

E Print filename when you select the index in layout

E Preview all layouts of A4 and Letter

Image | Select images from multiple folders
Selection

( Defaults )

® Cana ) (o)

If checked,
click to
remove the
check mark

Click to
close the
window

Specify the number of sheets to be printed, and then

click [Next].

Easy:PhotoPrint &

increase the
number of
sheets to be
printed
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Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

6 06 Easy-PhotoPrint

Click

— Select the
paper type

8 Specify the layout, and then click [Print].

Easy-PhotoPrint

]

nnnnnnnnn

EasyiPhotoPri

uuuuu

wwwww § IMG_0015.CR2

Select the layout

=» Printing begins.

Click to print

Additional information

© Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
© The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.82) to
[Perceptual] (p.128) and print.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.76).

R
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Introduction
Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Contents at

S a Glance
Select the image to be printed. Deleting an Unwanted Image
Be aware that you cannot recover deleted images.
Select the [File] menu » [Print]. Rih
. . . . Operation
Select an unwanted image in the main window.
Open in Edit window #O
Open in Edit window {enlaragdy Select the [File] menu » [Delete].
-'__.-g,:..,:i- window 3EN
Close window W Open in Edit window #0
Save %S Open in Edit window (enlarged) Advanced
Save As... 385 Close all Image Editing
Add thumbnail to image and save 36T el Wiy ®N and Printing
Convert and save... ¥D Close window i
Batch process... ¥#E Save 385 Processing
Save As... {r 35S Large Numbers
Gpemteen Rk ah Add thumbnail to image and save {+#T of Images
Page setup... 1+ 3P Convert and save... ¥D
( Print... #P ) Batch process... #B -
Print with detailed setting... T #HD JPEEd(I-Et/?IgFF
Contact Sheet Prints... ~3P Create new folder... fraN Imades
Plug-in printing > Page setup... {raep J
Add to collection H#G Pr?nt.... ) i &P
Rerieleire e lleetion ARG Print with detailed setting... {r 3D
¢ sk eollaction Contact Sheet Prints... ~3P Reference
Plug-in printing >
Delete #E :
e %1 Add to collection G
Remove from collection 3G
The [Print] dialog box appears. Clear collection Index
Set to photograph printing and print. ID*;'EW :I@ —
Specify the optimum settings for photograph printing in the & O": : .
printer’s print settings dialog box and click the [Print] button. The image is moved to the [Trash] and is deleted from DPP. @ @
Printing begins. The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop. @
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.

806 Digital Photo P

[
i 1

Folder Collection(0)
v =4 Mac0SX
» [A Applications
¥ Temporary ltems
¥ | & Users
v 4 canon
» [@ Desktop

» [ Documents
» [# Library

& Movies

[# Music

v’

>y
» [ Sites
» [ shared

Select the [File] menu » [Create new folder].

Open in Edit window #O
Open in Edit window (enlarged)

Close all

Open window 3N
Close window HEW
Save 35
Save As... {+35
Add thumbnail to image and save 3T
Convert and save... ¥D
Batch process... 3B

( Create new folder... {+3EN )

Page setup... {r 3P
Print... #P
Print with detailed setting... +#D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination
folder.

8086 Digital Photo Profession

i1 13,
(0F}

Folder Collection(0)
¥ =) MacOsX
» [& Applications
|2 Temporary Items
v & Users
v @ canon
¥ [@ Desktop
L2 Travel
» | ¥ Documents

» |® Library
|# Movies ®
& Music IMG_0001.CR2

¥ |2l Pictures r

v [7 Photo
L0 XXXX_XX_XX
b @ Public
» | Sites
» [ shared

The images are moved or copied to the destination folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be

80e Digital Photo Profession

Folder Collection(0)
v = Macosx
> | A Applications
[Z Temporary Items
¥ (£ Users
v & canon
¥ [@E Desktop
[ Travel
» | Document its
b [® Library
| = Movies

i

IMG_00D1.CR2

The folders are moved or copied fo the destination folder.

registered
g .
806 Digital Photo Profession
= i E
Folder Collection(0)
¥ 2 Macosx
P | & Applications
|2 Temporary Items
v & Users
v @ canon
¥ [@ Desktop
L2 Travel .
» [ Documents R ]
» |® Library
|# Movies ® i ®
& Music IMG_0001.CR2
¥ (il Pictures r
v 5
‘ [ xxxx,xx,xx} r —= Select
[ i
> [ Sites
» [ shared i

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic
dust erasure processing, various printing functions for printing out work,
and color management are explained here, geared to the user who is
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image... 53
Changing How the Window is Split...............c.eueeee..... 53

Adjusting by Comparing Multiple Images................. 54

Displaying an Area Beyond the Set Range as a

Warning Indicator (Highlight/Shadow Warning) ....... 55

Performing Advanced Editing.............cccoevviiiiinnn. 56
Adjusting White Balance with Color Temperature ..... 56
Tuning White Balance with Color Wheel ................... 56
Adjusting Dynamic Range ............ccccvvvvvveiiiiniiinnnnnnns o7
Adjusting Brightness of Shadows/Highlights ............. o7
Tone Curve Adjustment............ccccoiiiiiiieee e, 58

Example of a Tone Curve Operation ..................... 59
Using a Picture Style File..........ccoooiiiiiiiieeee 59
About the RGB Tool Palette ..............ovvvvvviiiiiiiiiinnnnes 60

Using the Auto Lighting Optimizer................ccooeeeeee. 61

Reducing NOISE........c.iiiiiiiiiieeie e, 62

Correcting Lens Aberration ..........ccccooooiiiiineeenn. 63
Compatible Cameras..........ccccvveeeeeeeeeeeeiicccceee. 63
Compatible Lenses.......ccccooveieiiiiiiiiiiee 63
Making Corrections...........ccceeeeeeeeiieeiiiiiiiiieeeeee e 65

Effects of Distortion Aberration Correction for Fisheye
LENSES ... .t 66
About Shooting Distance Information Slider.............. 68

Correcting Multiple Images at a Time......................... 68

Performing Automatic Dust Erasure Processing ..... 69
Compatible Cameras.............ccccooeeicciiiiiiieieeee e, 69
Automatic Dust Erasure Processing in the Main Window... 70

Manually Erasing Dust (Repair Function)................ 71
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCHION)....eee e 73

Transferring a RAW Image to Photoshop................ 73

Setting Work Color Space .........ccccooeevvveiiiiiiieeeeinnnn. 73

Printing with Shooting Information........................... 74

Printing a Thumbnail List (Contact Sheet Printing).. 75

Printing RAW Images on a High-End Canon Printer.. 76
Printing with a High-End Canon Inkjet Printer ............ 76
Printing with a Large-Format Canon Printer............... 77

Specifying Preferences...........cccoceeiieiiiiiiiiiieeieennnnn. 78
General SettingS.........ooooviiiiiiiiiiie e 78
View SettingS......ocooeiiiiiiiieee e 80
Tool Palette ... 81
Color Management..........cccooooiiiieeiiiiiiie e 82
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

Introduction
Changing How the Window is Split N

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Before/ c:r(';tfan.:zeat

after comparison]. In the edit window, select the [View] menu » [Display
mode] > [Spllt smgle |mage]

Basic
Operation

N —

Advanced
Operation

Imaggiltmg
and Pfinting

2 oy e One image is divided and dlsplayed on the left and right or top
The image divides into a left and right window. and bottom. Processing

The window on the right shows the image after editing. To switch between top and bottom, and left and right, perform the La‘r)gfe"r;llgrgggrs

Change the image display. same operation as step 2 on the left page. —

Select the [View] menu » [Change up/down/left/right] » [Up/ Editing

down]. JPEGI/TIFF
Images

806 '+ Digital Photo Professi

|

Reference

|

Index

oS
B 0020000 = iy RAW / Adobe RGB CMYK /.

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing. @

|

|§| Images can also be displayed in the edit image window by the same
operation.



Adjusting by Comparing Multiple Images e
You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
T ] : . windows, the enlargement display position will also change in the Contents at
In the edit window, display the multiple images to be other edit windows. a Glance
compared. To cancel synchronization, select the [Window] menu » T ——
. . hroni in.
Align the images. [Synchronize] again Basic
Align the images for easy comparison. Operation
Select the [Window] menu » [Synchronize].
gdvanced
. ti
Enlarge the image. e

Enlarge and display any of the edit windows.

@ Digital Photo pro Vi i Tools Window _Fel = G weds3iM @ Ad ced
606 v oigtal = OO %) Digital Photo Professional - [ MacOsX/Users /canon/Pictures /Photo/. n
Imag iting
: A and Pfinting

7 Processing
e .= AL : Large Numbers

- s WY okl ‘ : of Images

,,,,,,,, —— 5 - e 3 Editing
: JPEG/TIFF

Images
e

G

#* Reference

The other edit windows will also be displayed in the same
position/enlargement ratio. —

@ Synchronization only applies to the enlargement display position —
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the
image has exceeded that set range, you can display the highlighted part
in red and the shaded part in blue.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet.

Enter the warning value for [Highlight] and [Shadow].

Fr a|
Preferences

General settings | Miew settings | Tool palette Color management

Grid pitch
64 Pixels(8-256)

Locking selected image
B Images opened in Edit window remain selected in main window

Magnification in Edit window

{® Fit to window O 50% O 100% O 200%

Magnification when the Edit/Edit image window is double-clicked

® s50% O 100% O 200%

RAW and JPEG
Eﬁ Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window
# Retain sort order

Highlight/shadow warning

Highlight 255 | (9z-255 [N
Shadow o | (o-64 ]

Quick check tool display

® 508 () 100% (moiré reduction off)

I Cancel 3 f OK ’

Click the [OK] button to close the window.

Display the edit window.

Select the [View] menu » [Highlight]. Similarly, select
[Shadow].

On the opened image, if there is an area that exceeds the value
entered in step 3, the highlighted part of that area is displayed in
red and the shaded part is displayed in blue.

@ You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens/ALO] tool
palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

—--——[ RAW | RGE NR/Lens/ALD ————

|Erightness adjustment E_._?.J
“””:””m“”“:”_ 0.00
|White balance adjustment EE_:‘
= T o regiser 8
[r Calor temperature ':]]’ Tune..
r_‘ (sso0_k)—— Displays the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

enNnn White balance fine adjustment
Color tone: — Enter the values
Color saturation: to set
Cancel bN : oK ]
|
Drag

@ To register adjustment results as personal white balance (p.87),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

@ The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Introduction
Adjusting Dynamic Range Adjusting Brightness of Shadows/Highlights
Dynamic range (width of gradation expression) from dark points to bright You can adjust the brightness of shadows and highlights in an image.
points in an image can be adjusted. By adjusting shadows and highlights in an image with a restricted Cgrgfan:(s:eat
brightness, you can reduce the effects of clipping in shadows and
: highlights.
|P|clure Style ) || )
—— Move downwards Basic
P Standard [ 1 Br-c-w‘se... j Output hlghllght points |Picture S |£|| Operation
Standard | ¢] { Browse.. )
Move to the left or right - - . Advanced
Input highlight points i / Operation
TN = ————
Contrast: ()| T pe— i Ad ced
Highlight: o 100 -3.0 -60 -40 -20 0 20 40 I;n:g;:tl::rl]r;lg
Shadow: L) e .E 3. R Contrast: A i)
! Linear Move upwards Highlight: (VR ) Drag the sliders left or :
fior jonie | . Output shadow points ot o Tright Processing
i Large Numbers
Color saturation: (]} TET ] Linear of Images
Unsharp mask ! :] Color tone: o T@T T —
Strength: {0 @:ﬁ Color saturation: ) T@T o
Fineness: ] @ﬁ Unsharp mask F JPEEdét/I¥|gFF
Ahreshole: Ll g Strength: A Images
Fineness: o & —
Move to the left or right e b " @_
Input shadow points Siasi i
Reference
The horizontal axis shows the input level and the vertical axis -
shows the output level.
Index

S7



. Introduction
Tone Curve Adjustment Make adjustments.
Batch adjusts RGB

You can adjust the brightness, contrast and color of a specific area by

. Adjusts each channel
changing the tone curve (p.127). J Corgfnts at
——— RAW [“RGB~| NE/Lens (ALD &l e
In the tool palette, select the [RGB] tab sheet. [Tone chrve assist R
Tone cprve adjustment -y | Basic
. . T5 01w | g Operation
Select the tone curve mode and interpolation . < c ] ) 7} °
method. 255
[ RAW | RGB | NR/Lens/ALO gd\é?:tti:gg
|Tone curve assist O+ 2 ‘ P
Tone curve adjustment .y ‘
PR — — . . Ad ced
_"?‘f“l. i i . | 0 Click to add a [[] (point) |mag\5ﬁting
255 Adjust by dragging [] and Pfinting
Processing
Large Numbers
v Curve | of Images
Straight o O .
<control> + click inside 0 255 Editing
v FLtGB_R GEB = the graph to display the Hrightnass: —y— olfz) JPEG/TIFF
uminance menu A — - Images
Hue: e 2 o w
. Saturation: o o0] Reference
R = _d Sharpness: o A— - [ ol
0 s sz (ol <
Brightness: Wt -] C The horizontal axis shows the input level and the vertical axis
Contrast i e shows the output level. Index
e ———— (o] : The maximum number of [[] is 8. -
e —a—— o) 100 To delete a [[J], double-click on the [[T].
Sharpness: lr\:/'l"—' H T 0l

; 00

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any @
adjustments (p.81).

The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.81). 58



Makes medium tones brighter

Example of a Tone Curve Operation

Makes medium tones darker

J

74

/

Makes tones harder

Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon’s web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

‘ Picture Style iy ‘

Y ¥ E———
I Browse...

Standard

A

-10.0 -8.0 -6.0 -4.0 -2.0 O 2.0 4.0

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will
display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALQ] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

E\@/E Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens/ALO] tool palette (p.117)
when applying the Auto Lighting Optimizer (p.61), reducing noise (p.62)
or correcting aberration (p.63) after you have made any required
adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,

and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s

Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with
EOS-1D Mark IV, EOS 5D Mark II, EOS 7D, EOS 60D, EOS 50D,
EOS 600D, EOS 550D, EOS 500D and EOS 1100D.

* ALO stands for Auto Lighting Optimizer.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

" raw | RGE [| MRftenspmo )}

‘ Auto Lighting Optimizer

5 T

Low  Standard  Strong

‘ Moise reduction

Apply ‘

RAW " NE Preview... |
Luminance noise reduction
{ZJ D tryrrrrrrrrreri e 20
Chrominance noise reduction
5] 1] 20
TIFF/JPEG
Luminamce noise reduction
10 git=r 20
Chrominance noise reduction
10) g =y 20
Lens aberration correction Tune... ‘
Peripheral illumination 35
Chromatic aberration OFF
Caolor blur OFF
Distartion OFF

Checkmark the checkbox.

[ RAW | RGE |

NR/Lens/ALO |

‘Autn Lighting Optimizer

@& —

Low Standard  Strong

Checkmark

For images shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the settings according to your preferences.

[ RAW | RGEB |

NR/Lens/ALO |

‘Autn Lighting Optimizer

I

Low Standard  Strong

Select from three levels:

Low/Standard/Strong

Auto correction is applied to the image to match the settings.
For images shot with the camera’s Auto Lighting Optimizer
function, the settings at the time of shooting are applied as the

default values.

To cancel the Auto Lighting Optimizer, remove the check mark

from the checkbox.

@ When [Highlight tone priority] is set to [Enable] in EOS 7D,
EOS 60D, EOS 600D, EOS 550D and EOS 1100D Custom
Functions, the Auto Lighting Optimizer function cannot be set.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.
Click the [NR Preview] button.

MR Preview... |

| Moise reduction

RAW ﬁ

The [NR Preview] window appears.

Adjust an image.

8NN NR Preview

Navigator
window

— Enlargement
display
position

Luminance noise reducty
(]

S = Drag the
20 sliders

D | |

Chrominance noise redygay
{00

- Cancel

K

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.78) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

My
= To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALQ] tool palette (p.117) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

@ You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.81).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise] has been set, resolution may be reduced

along with reduction of noise.

If [Chrominance noise] has been set, color bleeding may occur

along with reduction of noise.

For a list of [NR Preview] window functions, refer to p.118.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses
EF 14mm f/2.8L USM EF 14mm f/2.8L Il USM*3
EF 8-15mm f/4L USM Fisheye*3 EF 15mm f/2.8 Fisheye*3

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D Mark I
EOS 5D*1 EOS 7D EOS 60D

EOS 50D EOS 40D EOS 30D*?
EOS 600D EOS 550D EOS 500D

EOS 450D EOS 400D DIGITAL EOS 1100D
EOS 1000D — —

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EF 20mm /2.8 USM

EF 24mm f/1.4L Il USM*3
EF 28mm /1.8 USM

EF 35mm f/1.4L USM

EF 24mm f/1.4L USM
EF 24mm /2.8

EF 28mm /2.8

EF 35mm f/2

Standard and medium telephoto lenses

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

EF 50mm f/1.4 USM

EF 50mm /1.8 I

EF 85mm f/1.2L Il USM*5
EF 100mm f/2 USM

Telephoto lenses

EF 135mm /2L USM

EF 200mm f/2L IS USM*3

EF 200mm f/2.8L Il USM

EF 300mm f/2.8L IS USM

EF 400mm f/2.8L Il IS USM*3
EF 400mm f/5.6L USM

EF 500mm f/4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm f/2.8L USM

EF 300mm f/2.8L Il IS USM*3
EF 300mm /4L IS USM

EF 400mm /2.8L IS USM

EF 400mm f/4 DO IS USM
EF 600mm f/4L IS USM
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Zoom lenses

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm /3.5-4.5 USM

EF 24-85mm /3.5-4.5 USM

EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 1| USM

EF 28-90mm /4-5.6 Il

EF 28-105mm /3.5-4.5 USM
EF 28-105mm /4-5.6 USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6 USM
EF 55-200mm f/4.5-5.6 1| USM
EF 70-200mm f/2.8L USM

EF 70-200mm f/2.8L IS 1l USM*3
EF 70-200mm f/4L IS USM*4
EF 70-300mm /4-5.6 IS USM
EF 75-300mm f/4-5.6 I1*3

EF 75-300mm f/4-5.6 USM

EF 75-300mm /4-5.6 Il USM
EF 90-300mm f/4.5-5.6 USM
EF 100-400mm /4.5-5.6L IS USM

EF 16-35mm f/2.8L Il USM*3

EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-105mm f/4L IS USM

EF 28-90mm /4-5.6 USM

EF 28-90mm /4-5.6

EF 28-90mm /4-5.6 Il

EF 28-105mm /3.5-4.5 1| USM
EF 28-105mm f/4-5.6

EF 28-200mm /3.5-5.6

EF 28-300mm f/3.5-5.6L IS USM
EF 55-200mm f/4-5.6 USM

EF 70-200mm f/2.8L IS USM

EF 70-200mm f/4L USM

EF 70-300mm f/4-5.6L IS USM*3
EF 70-300mm f/4.5-5.6 DO IS USM
EF 75-300mm f/4-5.6 I11*3

EF 75-300mm f/4-5.6 [l USM

EF 90-300mm f/4.5-5.6

EF 100-300mm f/4.5-5.6 USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm /2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm f/2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm f/3.5-5.6 IS*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 ISUSM  EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm f/3.5-5.6 I11*3 EF-S 18-55mm f/3.5-5.6 Il
EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 IS 11*3
EF-S 18-135mm /3.5-5.6 1S*3
EF-S 55-250mm f/4-5.6 1S*3

EF-S 18-55mm f/3.5-5.6 IS*3
EF-S 18-200mm f/3.5-5.6 1S*3
EF-S 55-250mm f/4-5.6 IS I1*3

Aberration correction will not apply to images shot with a combination
of lenses *3*4 *5 and EOS 5D or EOS 30D with the firmware versions

below.
* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EQOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens

even when the extender is attached.
You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under

“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

EF-S 18-55mm /3.5-5.6 || USM
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] Introduction
Making Corrections Checkmark the items to be corrected.
You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously. Cg'gfa“':geat
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image) Basic
Color blur (blue or red color blur which sometimes occurs at the edge Operation
of the highlighted area of an image)
Distortions =
e Advanced
In the tool palette, select the [NR/Lens/ALO] tab T m < h
sheet. Gt
Click the [Tune] button. Imgggjﬁf'ng
RAW | RGB | NRjLens/ALO } and Pfinting
|Autc| Lighting Optimizer |
o —— : : : : Processing
R T The image is corrected and redisplayed. Large Numbers
_ : R Check the results of corrections to peripheral illumination or of Images
e ST distortions in the full view.
RAW L NRPreview.. Check the results of corrections to chromatic aberration and color Editing
Eaim e ot Tecledlity blur by clicking the area on the image you want to check. In the JPEG/TIFF
- 0 R 20 top right of the window, the area is displayed at 200% in the Images

Chrominance noise reduction

enlargement display section (p.123).

. : You can lessen the degree of correction by moving the slider to
TIFF/JPEG the left for the item you want to correct. Reference
Luminance noise reduction You can respectively correct red chromatic aberration with the [R]
i R 20 slider of the [Chromatic aberration] or blue chromatic aberration
:Z;;rumlna.ntu noise r?ufﬂ?n . Wlth the [B] Slidel’.
To correct distortion aberration of images shot with a fisheye lens LR
Lo RORTOn IO (_Tune.. ]| (EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four —
effects can be selected from the [Effect] list box in addition to
Pericheral ikt o [Shot settings] normally used for distortion correction.
R ey OFF The level of an effect can be adjusted with the adjustment slider @ @
Color blur OFF located below [Distortion].
Distortion OFF For detailed information on each effect, refer to “Effects of @
Distortion Aberration Correction for Fisheye Lenses” (p.66).

The [Lens aberration correction] window appears.
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For images shot with EF 8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.

Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [g‘_D—'] mark is displayed on the image to
indicate the lens aberration corrections (p.114).

Effects of Distortion Aberration Correction for
Fisheye Lenses

Shot settings
By selecting this option, only distortion aberration correction for
correcting optical distortion is performed.

Emphasize Linearity

This converts the image to a “central projection” style image. This

projection method is used with general lenses.

Differing from fisheye lenses, central projection displays straight lines

as straight lines.
By selecting this option, a wide-view panoramic image can be

obtained. However, the periphery is stretched, resulting in decreased

L
YA
<< = =

VAN

-
\
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Emphasize Distance

This converts the image to an “equidistant projection" style image.
This projection method preserves distance relationships.

Equidistant projection displays the same distances from the center to
the periphery as the same distances.

In particular, when shooting a celestial body such as the celestial
sphere, any height above the horizon (declination) is captured at an
equal interval. This method is therefore used in such photography as
celestial photography (star maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correcily. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography.

By selecting this option, the center is stretched and may result in
decreased resolution.

@ While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.

Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il
EOS 5D Mark Il EOS 7D EOS 60D

EOS 50D EOS 40D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 1100D EOS 1000D —

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS 400D DIGITAL —

For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool palette] button (p.112) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.29) and/or the color saturation (p.96) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@ The periphery of the image may be truncated when [Distortion]
correction is made.

@ For a list of the [Lens aberration correction] window functions, refer
to p.123.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera

that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark 11l EOS-1D Mark 11l
EOS 5D Mark I EOS 7D EOS 60D

EOS 50D EOS 40D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 400D DIGITAL EOS 1100D EOS 1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

el %1 1/2 IMG_0050.CR2 [3456 x 2304]

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [3] mark (p.114) is displayed on an image from which dust
spots have been erased.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.71) or the copy stamp function (p.73).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

¥

~
-

= Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

ﬁl For a list of the copy stamp window functions, refer to p.124.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Click the button that matches the dust spot to be
. : erased.
In the main window, select the image you want to If the dust spot is dark in color, click the [ @»( |] button, and if
erase dust spots. the dust spot is light in color, click the [ (»()|] button.
Click the [Stamp] button. When you move the cursor over the image, the dust erasure

range appears as [O].
Place the dust spot to be erased within the [O] and
click.

806 (¥ 1/1 IMG_0050.CR2 [3456 x 2304]

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Click

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

8eNno (% 1/2 IMG_0050.CR2 [3456 x 2304]
100 view [ Full ice view
Dust Delete Data

s [ OO || @O

(_select Copy Source — 3

———————
opy Source
type

oo

Clrcethe dark spot o repalc.

The dust spot within the [Q] is erased.
Click on another part of the image to continue erasing dust spots
o Double- in the image.
bl click To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.

The [8,] mark (p.114) is displayed on an image from which dust
e ), spots have been erased.

The display changes to 100% view.
The display position can be changed by dragging.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.73).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

¥

Q> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots

one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the

erased dust spot displayed.

Switch between full screen display/normal screen display using

shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and

clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you

can efficiently erase dust spots by clicking the images while holding
down the <38> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, refer to p.124.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.71).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.114) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.89.

@ Compatible versions of Photoshop are CS or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.127) is added. The ICC profile
contains information about [Preferences] (p.82) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

Setting Work Color Space

A different work color space (p.128) from the default settings (p.82) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.82), this
default setting will not be applied and the individually set color space will
remain.

5@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

# IMG_0001.CR2

(’ Printer | Image = Text = Settings )

Printer :

Properties

Media
A4

Media orientation
) Portrait
@ Landscape

Media size:
297.0 mm x 209.9 mm

Print profile:

CMYK profile:

ey

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

-:@/5 To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.82).

If CMYK simulation has been set, the image is printed in the set
colors (p.82).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.
Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

Contact Sheet Prints

(J Printer | Image = Text @ Settings j\

Printer .

Properties
Media :

A4

Media orientation:

) portrait
C Landscape
Media size:

209.9 mm x 297.0 mm
Print profile:

CMYK profile:

CMS settings...

( Apply )( Cancel l( Print )

Print preview

@ To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.82).
If CMYK simulation has been set, the image is printed in the set
colors (p.82).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and
the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your computer.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.82) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.128), and try printing.

1/

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.73, p.82), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction
When the color space setting (p.73, p.82) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider

color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.78) and CMYK simulation (p.82) are not
applied.

/

< Advantages of printing with imagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.73, p.82), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.73, p.82) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Digital Photo Professional] menu »
[Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences

([ General settings View settings Tool palette Color management )

Startup folder

(*) Last displayed folder

() Specified folder

Browse... Canon 1/Users /{Canonl/Desktop

Save recipe

(*) Display message when adding file
() Add to file automatically

Viewing and saving RAW images

(®) High quality (recommended)
"] View images at high speed (moiré reduction off)
View/save RAW images at high quality
Mairé is reduced and the NR tool palette can be used
JPEG image quality

"] Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

" Edit image window enabled at EOS Utility startup

s 2
o
=
=

Cancel

General Settings

You can specify the folder that opens when DPP is started up, image

quality of displayed and saved RAW images, etc.

Preferences

Startup folder

(*) Last displayed folder
() Specified folder

Browse... Canon 1/Users/Canonl/Desktop

Save recipe

() Display message when adding file
() Add to file automatically
Viewing and saving RAW images

(%) High quality (recommended)
"] View images at high speed (moiré reduction off)
View/save RAW images at high guality
Mairé is reduced and the NR tool palette can be used
JPEC image quality

| Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

[ General setti ngs View settings Tocl palette Color management
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

® For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.42, p.88) and for JPEG images that have
been saved with a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.42, p.88).
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View Settings

You can specify settings relating to the display.

Preferences

General settings | View settings | Tool palette Colar management

Grid pitch

64 Pixels(8-256)

Locking selected image

S Images opened in Edit window remain selected in main window

Magnification in Edit window

—_

® Fit to window () 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

™ s0% ) 100% () 200%

RAW and JPEG

a Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window

# Retain sort order

Highlight/shadow warning

Highlight 255 {192-255) I
Shadow 0 (0-64) ]

Quick check tool display

@ s0% ) 100% {moiré reduction off)

( cancel ) 6 oK

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).
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Tool Palette

You can specify settings for the tool palette.

g ™y
Preferences

- General settings View settings | Tool palette | Color management -

Default settings of RGB Tone curve mode

Tone curve mode Tone curve interpolation method Histogram
M RGERGE ® Curve

) Luminance R G B () Straight

(") Before adjustment
®) After adjustment

Tool palette display in Edit Image Window
) Docking display
) Floating display

Modified Picture Style settings

E Retain settings of each Picture Style

Tool palette display mode

_! Same for Main window and Edit window

Default noise reduction settings

@ Apply camera settings

_ Set as defaults

RAW luminance noise reduction: {0)

RAW chrominance noise reduction: {a) &

TIFF/JPEG luminance noise reduction:

TIFF{JPEG chrominance neise reduction: {0)

f Cancel )€ 0K ]

Default settings of RGB Tone curve mode

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed or retained,
when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

—2@/3 Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

+ General settings View settings Tool palette Color management }

Default settings of Work color space
) sRGB

"~ Adobe RGB

" Wide Gamut RGE

_ Apple RGB

) ColorMatch RGR

CMM settings for print
For display :
%) sRGB

"~ Monitor profile
ENG /Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49E4 icc

Printing profile: Rendering intents:

None | t]

CMYK simulation profile; Rendering intents:

None J i]

Rendering intents when using Easy-PhotoPrint
:, Perceptual

(#) Relative Colorimetric

Cancel (’ 0K 3

Default settings of Work color space

You can select from five types of color space (p.128) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.88) or printed (p.43, p.46, p.49, p.74 to p.77).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.112, p.113), the edit window (p.115), and the edit image
window (p.120).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

@ You can set a color space that is different from the default settings
for each image (p.73).

Display setting (color setting of the monitor)

Where a profile (p.127) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

5@/3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.127) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.74, p.75) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.76, p.77).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

5@/3 Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.76, p.77), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.128) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.112, p.113,
p.115, p.120) in the bottom of the main window, edit window and edit
image window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.128) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptual].
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

Introduction

? Additional information

applied to another image. Recipe data includes tool palette contents Contents at
You can edit images efficiently by selecting and adjusting one image Recipe data includes adjustments made with the tool palette ([RAW], e
from images shot with the same shooting environment and batch [RGB] and [NR/Lens/ALQ]). For this reason, other editing content
applying the adjustment results to a large number of images. such as trimming or dust-erasure (copy stamp) is not included in the
e LT recipe data. Basic
= [:“:’m :“ et Recipes adjusted with the [RAW] tool palette can only be applied Operation
b (=) to RAW images
Lo Adjustments in the [RAW] tool palette, which can only be made for
s a RAW images, are not applied to a JPEG or TIFF image even if they Advanced
[7] Register..._ Operation
oot sem - are pasted.
Short settings B Tune. )
|Pi(lure Style |3|‘ Advanced
Standard l‘]( Browse... | Image Editing
Tt and Printing
Procefsing
— Larg bers
J10.0 80 -60 40 -20 0 20 40 g of Im ges
Contrast: o T
Highlight: ) ———— —_—
Shadow: EU: ’_.W . . Editing
Bt Contents adjusted using the tool JPEG/TIFF
Gl boe Ol o palette can be handled Images
e “”]_9— individually as a recipe file
Srength 0o (extension “.vrd”).
Ll | | Reference
Index
|§| The adjustment contents of JPEG or TIFF images (p.92) can be @

saved as a recipe file (extension “.vrd”) and loaded and applied to

another image in the same way as with RAW images. 85
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Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Operation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be' applied Sg‘é?Q{i’ﬁﬂ
o . _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
L : selected image].

and check the settings in the tool palette. When only a few settings are o ) _ Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

Procefsing
Largbers
of Images
Loading and Pasting Recipes -
iting
Select the image to which a recipe is to be applied, J'TES“;EF
and then select the [Edit] menu » [Read and paste J
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Introduction

Applying Personal White Balance

In the mﬁin window, .f;elect the image to which white Contents at
balance is to be applied. a Glance

Click the [Tool palette] button on the toolbar.

- - - The tool palette appears. Basic
Registering Personal White Balance _ _ Operation
Adi h hite bal Click the personal white balance number button that
just_t e w ite balance (p.27, 9.28, p.56). is to be applied.
To adjust white balance, select a setting other than [Shot Advanced
settings] from the [White balance adjustment] list box (p.27). You —{(RAW| RGB  NR/Lens/ALO j—— Operation
will be unable to register the adjustments if you select [Shot \Eﬂgmﬂfss adjustment LEL“
settings]. i P 0.0 Advanced
In the [RAW] tool palette, click the [Register] button. [White balance adjusiment [© ] h:r?c? ‘;Egtlﬁnr;g
The [Register personal white balance] dialog box appears. }i [| R ;‘[ Register... ¥
Select the button number to be registered from the o Sk | Procegsing
list and click the [OK] button. AT ers
8N [#| Register personal white balance el L?_J
Register current setting in personal white balance Standard | i] | Browse... ¥ Editing
- i . : JPEG/TIFF
Current setting: Click white balance |mages
[. Custom 1 f :]]
{  cancel | E——ok—)
: Reference
100 B0 60 -4.0 -20 0 20 40
Contrast: {0) '__9"_“
Highlight: o e — Index
Shadow: ] '—“-e—“
[l Linear
Color tone: {0 '—_e——'
Color saturation: )] "_"e'm
* Unsharp mask ‘] @ @
Strength: {0 9___—
Fineness: i) 6—-—-—-—-—-—-“ @
Threshold: {0 e—___'

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar
(p.112).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings

Save folder

IMG_0001.CR2
IMG_0002.CR2 ENG/Users/ canon/Deskiop (" Browse.
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2 Kind of file Exif-TIFF Bbit [ ]
IMG_0006.CR2 - =

Image quality 10
IMG_0007.CR2
IMG_0008.CR2 Output setting
IMG_0009.CR2 _—
IMG_0010.CR2 Output resolution 350 dpi [ Embed ICC profile
IMG_0011.CR2 Resize setting
IMG_0012.CR2 ) Resize
IMG_0013.CR2 Width Height Unit

aae

IMG_0014.CR2 3456 | 2304
IMG_0015.CR2 {3456 pixel ) {2304 pixel )

¥ Lock aspect rari

File format

File name

@ Current file name
String

: New file name
String Sequence number
DPP_ 0001

Ex.: IMG_0D01.TIF, IMG_0002.TIF

Image transfer settings
| Open image using software

( Browse.. )

Cancel € Execute )

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in
the batch processing dialog box.

In the processing dialog box, click the [Terminate] button.

"2 [Save] cannot be performed

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.107) to edited RAW images.

-3@/3 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

Q¢ skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

@ If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.100) or dust-erased image (p.69 to p.73, p.103 to p.107)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, refer to p.125.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.73), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after quitting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar

(p-112).
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

Batch settings

IMG_0001.CRZ Save folder

IMG_0002.CR2 MacQSX/Users /canon/Documents ( Browse.. )

MCen0n3eRe File format

IMG_0004.CR2

IMG_0005.CR2 Kind of file Exif-JPEG i+

IMG_0006.CR2 : ey
Image quality Yoo

IMG_0007.CR2

IMG_0008.CR2 Qutput setting

IMG_0009.CR2 o

IMG_0010.CRZ Output resolution 350 dpi [ Embed ICC profile

IMG_0011.CR2 Resize setting

IMG_0012.CR2 ] Resize

IMG_0013.CR? width Height Unit

IMG_0014.CR2 3456 [EEE 2304

IMG_0015.CR2 (3456 pixel ) (2304 pixel )

v
File Name

 Current file name
string

@ New file name
String Sequence number

DPP_ T ool " [l Save sequence number
Ex: DPP_ODO1.JPG, DPP_0002.JPC

Image transfer settings
™ Open image using software

' ___ Browse.. ' '

Cancel ) [ Execute)

The [Open] dialog box appears.

Select Photoshop CS.

In the [Open] dialog box, select a Photoshop CS file or an alias
and click the [Open] button.

The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

pen image using software

Adobe Photoshop C5 { Browse.. )

f Cancel 3 ( Execute }

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings (p.126) and click the
[Execute] button.

MacOSX /Users /canon/Pictures /Photo / xxxx_xx_xx

File Name Extension

[ <]

DPP | Shooting Date,/Time :}‘ Seguence number ﬂ Do not change L‘

Basic Settings Format settings

Sort Sequence number
@ Fit to main window 0001 " Save sequence number
(_ File Name

( Shooting Date/Time Shooting Date/Time

f Month Day Year "|
__ Copy & Rename MM-DD-YY ZJ
MacOSX/Users/canon/Desktop ™ Insert underbar
Original File Modified File Name
IMG_0001.CR2 B o ~ M |DPP_09-13-06_0001.CR2 R
IMG_0001.JPG DPP_09-13-06_0002.JPC
IMG_0002.CR2 DPP_09-13-06_0003.CR2Z
IMG_0002.JPG DPP_09-13-06_0004.JPC
IMG_0003.CR2 DPP_09-13-06_0005.CR2Z
IMG_0003.JPG —+ DPP_09-13-06_0006.JPC
IMG_0004.CR2 DPP_09-12-06_0007.CR2Z
IMG_0004.JPG DPP_09-12-06_0008.JPCG
IMG_0005.CR2 DPP_09-13-06_0009.CR2
IMG_0005.JPG i DPP_09-13-06_0010.JPCG
€ ) € : ]

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file name
has been duplicated. Changes cannot be made if even one file name has
been duplicated. Change the settings so that duplication does not occur.

® The name of the movie files cannot be changed in DPP.

@ You cannot start up the rename tool from the [Collection] window
(p-36, p.113).
For a list of the rename window functions, refer to p.126.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.21).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

MacO5sx

File Name

DPP :. Shooting

Basic Settings

Sort

[ f*) Fit to main window ]
__ File Name

;-1 Shooting Date/Time

Specify the required settings (p.126).
To copy an image, checkmark [Copy & Renamel].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.

® If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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5 Editing JPEG and TIFF Images

Trimming and Adjusting the Angle of an Image..... 100

Introduction
a DPP is software mainly aimed for advanced RAW image editing, but it —
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. C:rcl;tfan;(s:eat
Editing JPEG and TIFF Images..........cccccceveiin. 92 B
About the RGB Tool Palette .........cccoooevveveieeiiiinnnnnn.n. 92 Operation
Automatically Adjusting Brightness and Color (Tone —
Curve AsSISt) ........coocciiiiii i 93 Advanced
Adjusting Brightness and Contrast ............c.c.cc.c........ 94 SEsTatloy
Adjusting Color Tone Using Click White Balance........ 95
L . Ad d
Adjusting Hue, Saturation and Sharpness.................. 96 ,mag‘éaggﬁing
Tone Curve Adjustment...........ocoeeeeeeeeeeieeeeeeeeeee. 97 |gEudisiating
Adjusting Dynamic Range ..............cccceevvciivrveeeenenn... 98 Processing
: : Large Numb
Reducing NOISE ........ccoiiiiiiiiiiiiiiiiiieieeee 99 ggfelmg’;ese’s

Performing Automatic Dust Erasure Processing ... 103 J%Eﬁ’:,:
Compatible Cameras...............cceceuveeeeeeeeeecnnnne.. 103 Im#Ges
Automatic Dust Erasure Processing in the Main
WINAOW ..., 104 Reference

Manually Erasing Dust (Repair Function).............. 105 S
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCHON). ..., 107 Index

Saving Editing ReSUILS...........ccooveveeeeeeeceeeeeeee 107
Saving Editing Content to an Image......................... 107
Saving as a Separate Image .........cccccvvvveeeeeeeiiie, 108 @ @

Applying Editing Contents to Another Image......... 108 @

Printing ...cooeee e 108

Re-Editing an Image........cccccooeeiviiiiiiii i, 108
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens/ALQ] tool palettes.
Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

000 [¥ IMG_0D15.JPC
RAW ["RGB| NR/Lens/ALO

Tone curve assist V[
LD+

Tone curve adjustment
wee ] R G| ¢s |
e

255

v

Ll

l

K

™ JPEG, TIFF image data

0 e | —
s——— recipe|
: —
Brightness: e S 0. e
:

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.vrd”) (p.85, p.108).

Hue:
Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.107), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.85, p.108).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.97) and
automatic adjustment (p.93), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.127). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

" RAW | RGB | NR/Lens/ALO
[Tane curve assist ' 0 |7+ s ——Reverts the tone curve
Tone curve adjustment =3 to the original settings
We] « o]+ |
255 High
Standard
D 1
0 255
Brightness: 0 i
Contrast: ?
Hue trrrererrrrererere |'r'b-—': I:l E
Saturation: I:_'_ﬁJi 100 i
Sharpness: Ib.i ol

The tone curve changes as adjusted.

=Q< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

» Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

» Images which have extreme backlighting

@ If you click the [] button, the tone curve as well as the [Hue]

and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.96).
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Introduction
- = . Brightness: Move the slider to the right to make an image
AdeStlng Brlghtness and Contrast brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance

contrast of an image stronger and to the left to —

[Tone curve assit 0 [+ 20] make contrast weaker.
Tone curve adjustment - ||

Ree| R [ c | 8 |

255

RAW | RGB | NR/LensfALO

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

—_—

Processing
Large Numbers
of Images

Drag the sliders left or

0 255 | . E
. = fght JPEGIFF
Brightness: 0= | es

Contrast: g-—l Enter numerical values

Hue: (IR EEN RN (AR RN ARNE |EJ o 3

Saturation: |2J 100 ? Reference
(RN AR AN RN S

Sharpness: e—‘ ] [
p (RN AN AR R AN RN lal D -:- e

@ The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[*]] button.

I

RAW | RGB | NR/LensfALO

e
(2]

|Tnne curve assist

Tone curve adjustment

Rjc]e]

=
S
|l
i

Enghm!ss.‘ e rrreerer e D.;f
Contrast: ’_6— o)
AR AR R SRR AR —t
,—e—.' - . la)

Hue L rerrnrenni lEJ D :‘
Satur&tlun- (RN AR AN RN LEJ lDD L
Sharpness: Q—- \ (=)
p (RN AN AR R AN RN EJ D L

Click on a point that is to be the standard for white.

000 %! Digital Photo Professional - [ MacOSX/ Users /canon /Pictures/Photo /xxxx_xx _xx/IMC_0010JPC ]

(1167, 547); 216,222,233 High quality RAW / Adobe RGB CMYK /7

The coordinates of the cursor position and the RGB values (8-bit
conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.81).

J
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Introduction
Adjusting Hue, Saturation and Sharpness Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones
You can adjust hue (tone) and saturation and make the overall redder.
atmosphere of an image harder or softer. : : : Contents at
p g . Saturation: Move the slider to the right to make the color a Glance
deeper, and to the left to make the color weaker.
RAW | RGB | NR/Lens/ALO Sharpness: Move the slider to the right to make an image _
[Tonecorve s (0o o) harder, and to the left to make an image softer. o ia;glt?on
Tone curve adjustment =T P
e R [ c | s | @
255] | Advanced
Operation
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
0 e, | E g
o e JP IFF
e | es
Brightness: R - 0.
Contrast: ‘_@—”““”” S ni
Hue: : Reference
Saturation: B8 } Enter numerical values
Sharpness:
Index
Drag the sliders left or right 2> Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the @ @

sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a
value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.127).

Select the tone curve mode and interpolation

method.
RAW | RGB | NR/Lens/ALO
|Tone curve assist O B2y ‘
Tone curve adjustment - ‘
e R [ c | & | 7|
755] '
v Curve
Straight L
<control> + click inside
v RGERGE the graph to display the
Luminance RG B menu
il
D_ 1|
0 255
ErlghtnEss .:I:.IIIII\.I::I:.IIIII D :
Contrast pesECEs: » soECoEED ot
Hue :I:."IIIY:I:."::I 2 D :
Saturation: .D\” 3 100 2
Sharpness: !‘\:/'l"—' B 0 :

Make adjustments.

Batch adjusts RGB
Adjusts each channel

——+— RAW | ROB | NR/Lens/ALO

|Tone Clurve assist S e |
Tone curve adjustment -y |
R[] [ c | s J [ #]
2552
_D-___ e |
0 255
Brightness: '\/' 0 1
Contrast: "‘:"v' _Di
Huze: Ry e, 2 o :
Saturation: .DV Eﬁi
Sharpness: t:I"—-v 9—0:

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[] is 8.

To delete a [[], double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.81).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.81).

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editihg
JP IFF
| es

Reference

Index

00
©

97



Introduction

Adjusting Dynamic Range 5 © The setting range of shadow points is 0 to 247 (in 1-stop N
Dynamic range (width of gradation expression) from dark points to bright increments when entering a value).
pgints in an image can be adjusted The setting range of highlight points is 8 to 255 (in 1-stop Contents at
' increments when entering a value). a Glance

The histogram display changes according to adjustment. You can T ——
also fix the histogram display to the display before any

Move downwards

Output highlight points adjustments (p.81). Basic
; Operation
RAW [RGB | NR{Lens/ALO
Tone curve assist Iﬂ—"&"@d
Tone curve adjustment Ej—— Reverts the gdvan".:ed
G« | c [ ;] || image to the peration
Output ——— 253 O”g_mal
highlight point settings Advanced
numerical Image Editing
Processing
Move to the — Move to the Large Numbers
right left of Images
Input shadow Input highlight
points points E g
. JP%IFF
: i | es
Outputshadow |- ¢ J
point numerical 0 2551— Input highlight
value Eﬁghtﬂe}S; S ———— o :/| point numerical Reference
Co seipm—— ) value
Input shadow — e . : —
point numerical | Hue: —pe—ol 0]
value Satration: o) 100]) Index
Sharpness: @—””””_‘m””m“ | 0 z L]
Move upwards
Output shadow points @ @
The horizontal axis shows the input level and the vertical axis shows @
the output level. Q‘



Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

Click the [NR Preview] button.
|Noise reduction

RAW ﬁ NR Preview... |

The [NR Preview] window appears.

Adjust an image.

ann NR Preview

Navigator
window

— Enlargement

display
TIFF/JPEG pOSitiOl’]
Luminance noise reducty
g’ S = Drag the
CRE () —— 20 sliders

4 Cancel ) ( Apply )

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.
Noise reduction is applied to the image and the image is
redisplayed.

Ny

== To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALQ] tool palette (p.117) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

@ If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.81). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.
For a list of [NR Preview] window functions, refer to p.118.
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Trimming and Adjusting the Angle of an Image :
Introduction
You can trim only the part of an image you need, or change the Adjust the angle of the image as needed.
composition of an image where an image shot horizontally becomes Trimming/angle adjustment window
vertical. You can also adjust the angle of an image before trimming. TN
Corz;tfnts at
] : a Glance
Select the image to be trimmed. Largest ]
----------------- possible
. . . . trimming Basic
Opgn the tr_|mn_||nglangle adjustment window. range Operation
Click the [Trimming Angle] button. =) Click
Digital Photo Professional - [ MacOSX /Users/canon/Pic (rotate
image left Advanced
or right in Operation
777777777777777777777777777777777777777 90-degree
increments) Advanced
Image Editing
e i and Printing
Drag® (0.01-degree increments; —
adjustment range: -45 to +45 degrees) P .
rocessing
Large Numbers
The trimming/angle adjustment window appears. Use the mouse (click A/V) to adjust the angle or of Images

Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window. Reference
If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.
Index

@ When aspect ratio information is attached to an image shot with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D,
EOS 60D or EOS 600D, the trimming range based on the aspect
ratio information is displayed.
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Select a ratio and drag the trimming range.

8ne [¥ 1/1 IMG_0001JPG [3456 x 2304]

—— Cancel

. Select a
trimming
ratio

Drag the
trimming
range

(704, 362) -> (2281, 1413 ) = (1577 x 1051) [ 1.50

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.114).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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"2 About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.108).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.114).

 Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.108).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D, EOS
60D or EOS 600D, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 60D or EOS 600D, its trimming range cannot
be changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.122).

The image is displayed in its trimmed condition.

Ny

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

© For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, refer

to p.122.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark 11l EOS-1D Mark 11l
EOS 5D Mark I EOS 7D EOS 60D

EOS 50D EOS 40D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 400D DIGITAL EOS 1100D EOS 1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

eno ¥ 1/2 IMG_0050 PG [3456 x 2304]

6116 100% View to perform stamp eperation. Z

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [8,] mark (p.114) is displayed on an image from which dust
spots have been erased.

@ Dust Delete Data is not attached to images having settings specified
during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.108).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.105) or the copy stamp function (p.107).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.108).

Ny

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

@ For a list of the copy stamp window functions, refer to p.124.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editihg
JP IFF
| es

Reference

Index

00

104



The display changes to 100% view.
The display position can be changed by dragging.

Click the [OK] button to return to the main window.
The [@,] mark (p.114) is displayed on an image from which dust
spots have been erased.

Manually Erasing Dust (Repair Function) .
Introduction
You can erase dust spots in an image by selecting them one by one. Click the button that matches the dust spots to be
__ : erased.
In the main window, select the image you want to If the dust spot is dark in color, click the [ @»() [] button, and if Contents at
erase dust spots. the dust spot is light in color, click the [ () ] button. a Glance
Click the [Stamp] button. When you move the cursor over the image, the dust erasure
range appears as [O]. Basic
Digital Photo Professional - [ MacOSX /Users/canon/Pic Place the dust spot to be erased Wlthln the [O] and Operation
V@ 9@ @ click.
otate right 3::: Stamp Frimming Batch Advanced
Operation
: Advanced
O Click Image Editing
. and Printing
The copy stamp window appears. S —
When the image has redrawn itself, double-click the Processing
. . Large Numbers
point from where dust is to be erased. of Images
M Eqpeng
= — ; JPI%IFF
- e i o = | es
The dust spot within the [Q] is erased.
Click on another part of the image to continue erasing dust spots
Double- in the image. G
click To erase dust in another part of the image, click the button —
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3. Index
When the dust spot cannot be erased, [{§)] is displayed.

00
©

105



? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.107).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.108).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.108).

Ny

== Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to

the previous dust spot.)
Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the

erased dust spot displayed.

Switch between full screen display/normal screen display using

shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <g8> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and

clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you

can efficiently erase dust spots by clicking the images while holding
down the <38> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, refer to p.124.
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Saving Editing Results .
Introduction
Erasing Unwanted Parts of an Image (Copy Stamp Function) Saving Editing Content to an Image
You can correct an image by pasting a section copied from another part All the contents (reci : :
: ) pe) adjusted with the tool palette (p.92 to p.99) as Contents at
of the image to an unwanted part of the image. well as the trimmed range (p.100) and dust-erasure (p.103 to p.107) a Glance
. . ) information can be saved to a JPEG or TIFF image, or to a separate
Follow steps 1 to 3 in “Manually Erasing Dust (Repair JPEG or TIFF image.
Function)” (p.105). o Basic
. . . Select the [File] menu » desired item. peration
Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key, Open in Edit window #0 Advanced
o _ Open in Edit window (enlarged) Operation
To change the section that is to be the copy source, perform the Clase all
operation above again. EN
To fix the position of the copy source, checkmark [Fix Copy Gz windon i : Advaélg_?pl
Source position]. [ save %S mage Editing
P ] SHtA A %S and Printing
Correct the image. Add thumbnail to image and save {+ 3T
Click or drag on the section you want to correct on the image. [+] g;'l‘:;;ggszwe"' :BD LPFOCSSSiSQ
in the window indicates the copy source and [Q] indicates the a;gflcim:ge:rs
copy destination. Create new folder... {r 38N
The copied image is pasted in the position to which it was Page setup... T3P E g
dragged Print... JEP JP IFF
' ) Print with detailed setting... {+#D I es
For [Pen type], you can select from [Brush] (the pasted image’s EenizctShestPrints ~3ep
borders simulate a brush) and [Pencil] (the pasted image’s Plug-in printing >
borders are sharp). Add to collection %G Reference
. . . R f llecti {+ 3G
Click the [OK] button to return to the main window. e Ll
The [@,] mark (p.114) is displayed on a corrected image. Deleia e
Info... £ Index
Your adjustments are saved to the image.
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.92 to p.99)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.100) or dust-erased image (p.103 to
p.107) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.88)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.85)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.74)

Printing a thumbnail list (contact sheet printing) (p.75)

Printing RAW images on a high-end Canon printer (p.76)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.92 to p.99), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.100) or dust-erased image (p.103 to
p.107) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.107) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

~ Adjustment
Rotate left L
Rotate right R
Work color space |

Tone Curve Assist - Standard
Tane Curve Assist - High

Revert to last saved settings " 36Z
Revert to shot settings =

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting.........ccueiiiiiiiii 110
Deleting the Software (Uninstalling) ...................... 111
List of Main Window (Folder Window) Functions .. 112
List of Main Window (Collection Window) Functions... 113
Image Frame Information in the Main Window and Edit

Image Window...........cooeiiiiiiiiiic e 114
List of Edit Window Functions ...............cccceeeennnn... 115
List of Tool Palette Functions ............ccccveeeeennnnn... 116
List of NR Preview Window Functions................... 118
List of Quick Check Window Functions ................. 119
List of Edit Image Window Functions .................... 120

List of Convert/Save One Image Window Functions 121
List of Trimming/Angle Adjustment Window Functions 122
List of Lens Aberration Correction Window Functions 123

List of Copy Stamp Window Functions.................. 124
List of Convert/Save Multiple Images Window (Batch
Processing) Functions............ccccooviiiiiiiiiiiiiciiiiiinnns 125
List of Rename Window Functions........................ 126
GlOSSANY oo 127
INAEX . i 129
About This Instruction Manual.............................. 133
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card.

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.69 to p.73, p.103 to p.107) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.116).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.112, p.119, p.120),
trimming (p.38, p.100), dust erasure (copy stamp) (p.69 to p.73, p.103
to p.107) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.116).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D Mark 1V, EOS 5D Mark II,

EOS 7D, EOS 60D, EOS 50D, EOS 600D, EOS 550D, EOS 500D
and EOS 1100D. You cannot apply the Auto Lighting Optimizer’s
adjustment contents to RAW images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.73,
p.82) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sRGB color space. In this case, set the RAW image color space
to sSRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.82) and a profile for a printer is
set up correctly (p.82), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.76, p.77) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D and EOS
300D DIGITAL may not display image information (p.10, p.23).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

) : 2 =
B Hm 3
—— //3. 2 8

Address Book Automator Calculator Canon Utilities Dashboard Dictionary

©.

Font Book Front Row i it Image Capture isync

va-XoK } .

Photo Booth Preview

.-®

System Preferences TextEdit Time Machine Utilities Open in Finder

gr B e &y

2 IN= L. ois s
Drag the folder for the software to be uninstalled to
the Trash.

QuickTime Player Safan Stickies

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.
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List of Main Window (Folder Window) Functions (.10

Shows/hides the tool palette (p.116)
Shows/hides the folder area

Image information (p.23)
Selects all images

Cancels selection of all images
Displays the quick check window (p.119)

Displays the trimming/
angle adjustment

R

Introduction

|

Switches to the edit image Displays the copy stamp window (p.124) V|V'nd°W (p-122) Contents at
window (p.120) i a Glance
@| Digithl Photo|Profess View Bookmark Label |Adjustmjent Tpols Window Help E 4 Wed 10:48 AM Q 1
Digital Photo Professipnal - [ MacOSX/|sers/canon/Pictures/Photo/xxxx_xx_xx ] Folder path —
Toolbar*" Batch on/
. atch conversion .
[Collection] tab sheet*® : Basic
Folder! tab sheet*5 e saving Operation
oider] tab shee polcen
[ ] v 5 Macosx o (p88, p89, p125)
’_‘:_&_ Applications 1 I t t
[ Temporary Items =3 — ma e I'O a |On
= 2 (90 (gjegree units) Atranged
V’E Desktop o Operation
Check mark (p.19) e
1 Documents
> ‘] Library .
Ty . .‘:*;;.ﬂlﬁﬁ? D e | oo S | Rating (p.19) Advanced
v & f‘i.cture; Image Editing
' and Printing
» (@ public —
b - Sites
» [ shared Processing
Large Numbers
Folder area*2 of Images
i lan CNWENEEE | o NG G
Editing
JPEG/TIFF
Images
- N —
e ™
' MG ODILCRZ  |@m MG OOLZCRZ ' MG ODI3CRZ ' MG ODL4CRZ MG ODIS.CRZ Reference

I CMYK simulation
display (p.82)

Adobe RGB / Adobe RGB

High quality

Recipe I::Iata: Yes Numbar‘al images: 15 Number qu selected images: 1 CMYK

Image color space and workJ Display mode**

color space*3 (p.73, p.82)

|
Number of selected images

Recipe attachment status (p.85) Number of displayed images

*4 The item selected in [Viewing and saving RAW images] (p.78) of the
[Preferences] window is displayed.
*5 You can switch between the [Folder] and [Collection] windows.

*1 To switch between show/hide, select the [View] menu » [Toolbar].

*2 The images inside the folders selected here are displayed in a
thumbnail list on the right.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette.
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List of Main Window (Collection Window) Functions ¢

Image information Cancels selection of all images

Selects all images

Shows/hides the tool palette Displays the quick check window

Displays the copy

Sywtches to the edit image ’ stamp window
window ,\
@| Digital Photo|Professional Fil§ Edit |View Bookmark Label |Adjustmient Tools Window Help E 4 Wed 9:46 AM Q
eana Di¢jital Phollo Professional - [Collection]
Toolbar

Batch conversion/

[Collection] tab sheet*’ saving

[Folder] tab sheet

Folder

— Displays the trimming/
angle adjustment
window

. _
. Rating

IMG_0002.CR2 IMG_0005 CR2 IMC_0D07.CR2

IMG_0001.CR2 IMG_0006 CR2 e

— Image rotation
(90 degree units)

— Check mark
Adobe RGB / Adobe RGB High quality RnacipeI data: No Numbar‘ol images: 7 Number of selected images: 0 CMYK //2 — CMYK Si m Ulation
| | displa
Image color space and work4 Display mode Number of selected images play

color space*? (p.73, p.82)

Recipe attachment status Number of displayed images

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool
palette.

*1 The total number of images added to the [Collection] window is
displayed in the (') in the [Collection] tab sheet. Accordingly, when an
image is added that is displayed as a single image (p.22), twice the
total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (.10, p.34)

Introduction
Information displayed when [Large thumbnail] (p.10) is selected
B;B‘B i : Digital Photo Professional - [ MacOSX /Users/canon TS
’ . = ontents a
2 a Glance
" == == (& AL 7 -
Basic
Folder Collection(0) RS atel
Check mark ¥ = MacOsX
(p.18, p.19) » A applications Copy stamp mark Advanced
T [¥ Temporary Items (p.69to p.73, p.103 Operation
¥ [& Users to p.107) SRR
v @ canon Lens aberration
v [ Deskrop correction mark (p.65) Advanced
L'__ Travel . . *6 Image E-dltlng
. - Trimming range and Printing
Rating mark P % Documents (p.38, p.100) —
(p.18, p.19) > (M Library :
@ Movies Processing
Brightness adjustment L& Music La(r)gf.eirﬂ:r;;):rs
value*' (p.26) ¥ [ Pictures é
v [ Photo 3
11 Aperture o
W Editin
g BRI e B JPEGITIFF
p- g Public IMG_0001.CR2 L e IMG_000 Images
> (1 sites b | [ — e -
RAW adjustment mark*! *4
. . *1 .
White balance icon*™' (p.27) File name RGB adjustment mark*! *5 Reference
Unsaved editing content mark
Image type*? Shutter speed*>
*1 Does not display with [Small thumbnail].

*4 Displays in an image edited with the [RAW] tool palette in the edit
*2 Displays in RAW+JPEG images displayed as a single image (p.22). window and the edit image window.
[RAW] is displayed in RAW images. *5 Displays in an image edited with the [RGB] tool palette in the edit
(In [Small thumbnail] (p.10), [R] is displayed.) window and the edit image window.
*3 Does not display with [Medium thumbnail] or [Small thumbnail]. *6 When aspect ratio information is attached to an image shot with

EOS-1D Mark 1V, EOS-1Ds Mark 1ll, EOS-1D Mark 1ll, EOS 7D,
EOS 60D or EOS 600D, the image is displayed as a trimmed image
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List of Edit Window Functions .11, p.25)

Path and file name of image

Tool palette*! (p.116, p.117)

an00 # Digital Photo Professional - [ MacOSX /Users /canon/Pictures /Photo/xxxx_xx_xx (IMG_0001.CR2 | ] Oy I-}: IMG_0001.CR2
|————{"RAW | RGB | NR/Lens/ALO
|Erighmess adjustmant = |
|Whila balance adjustment - |
Py
Shot settings [ :] [: Tune... )
|Picture Style B ||
Standard 4] ( Browse.. )

RAW iIAdDbE RGE CMYX High qu?htv %A

( 918, 1282): 79, 81, 93

;100 3.0 6.0 -40 20 0 20 40

Contrast: (o T@T
Highlight: (I T A
Shadow: U B ity
[ Linear
Color tone: ] T@T
Color saturation: o T@T
Unsharp mask e
Strength: ] m
Fineness: o 6......‘...
Threshald )] 6,,,,..‘.”

Display mode**
Information display*2 . o
CMYK simulation display (p.82)

Image color space*® and work color space (p.73, p.82)

*1 To switch between show/hide, select the [View] menu » [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.78) of the
[Preferences] window is displayed.
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R

List of Tool Palette Functions S
RAW Tool Palette (p.25) RGB Tool Palette (p.60) —
&3 o ¥ IMG_o001.CR2 e ¥ IMG_0001.CR2
BN RGE | NR/Lens/ALO R | RGh| NR/Lens/ALO Automatic adjustment C:'gfangzeat
Brightness adjustment = Tone curve assist Ol | .
| = — > Brightness adjustment (p.26) S— L_Jl_+J|L; (tone curve assist) (p.33, p.93)
wmabmncudju“mm I_b_] f RCB ‘ R | C | B | P Click white balance (p.95) Basic
P 255 .
_ - meem L —— White balance adjustment Opsration
| (e L ST 1 (p.27, p.28, p.56) - Tone curve adjustment
]Piclureswle [ m (p58’ p97) Advanced
—I—— Picture Style settings (p.26, p.59) Operation
d 4 3 e
L 3C %mw“'" > - Dynamic range adjustment (p.98) —
Advanced
L Dynamic range adjustment (p.57) Image Editing
£ and Printing
L 2 A . —_—
LS008 o0 40 20" 9 Z60A0 - | _ . . 25?’
Contrast: ] ——— Contrast adjustment (p.29) T 5 =5 Brightness and contrast L:rocﬁSSitr:g
Highlight: b o 1 i . . . : ] ) ac P rge Numbers
G oo Shadow/highlight adjustment (p.57) | conast = ol adjustment (p.94) - Images
[ Linear Linear setting (p.29) Hue: —f@——(b]" , .
E‘”:"”";‘*: L i for Color tone and color saturation Saturation: o) 100 Hu9e6and Saturation adjustment Editing
P o adjustment (p.29) S g (p-96) JPEG/TIFF
|
Strength: © i . Sharpness adjustment (p.96) __mages
Fineness: {m@—' —— Sharpness adjustment (p.31)
Threshold: (0) @T 5 ‘
o ) ) peco s Reference
Sharpnass: ) W | i |
Enlargement display position* —— Enlargement display position*

* If an image is displayed enlarged, the enlargement display position can be
moved by dragging. The enlargement display position appears when
[Docking display] (p.81) has been set and the edit image window (p.120)
has been enlarged.
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Introduction
NR/Lens/ALO Tool Palette NR/Lens/ALO Tool Palette
(When a RAW image is selected) (When a JPEG or TIFF image is selected)
000 I¥] ING_1001.CR2 3 als % IMG_L00LIPC Contents at
——[ RAW  RGE | NRfLens/ALO | —— RAW  RCB | NR/LensfAlO | a Glance
IAntn Lighting Optimizer | |Autn Lighting Optimizer |
s @ T - Auto Lighting Optimizer (p.61) e Basic
\l Low  Standard  Streng y Low  Standard  Strong Operation
|Noise reduction l—ﬂplﬂ\f_ﬂ— Apply noise reduction button (p.62) |Noise reduction L—Mlll'r_TI— Apply noise reduction button (p.99)
R ~__mreevew. 71— Displays the [NR Preview] window R __weeien -+ Displays the [NR Preview] window
: minance noise reduction (p62’ p1 18) . minance noise reduction 99v 1 18
( = o —— J— Luminance noise reduction for s e S (p-99, p.118) Sg‘é?:t‘i:gg
] RAW |mages (p62) Chrominance noise reﬂu::t_il?.r? ;
2 : L Chrominance noise reduction for 2 = 2
_TIFF/JPEC RAW images (p.62) TIFF/JPEG Advanced
Luminance noise reduction [ Luminance noise reduction J— Luminance noise reduction for Image Edltlng
o 2 8 C o RSO Ao JPEG and TIFF images (p.99) and Printing
Chrominance noise reduﬂ_iun Chrominance noise reduction
iy 0 G @ o %~ ® | Chrominance noise reduction for S :
Lens aberration correction fue. ] —— Lens aberration correction tuning  |[Eenssbemion corecion | JPEG and TIFF images (p.99) La,;?ﬁj,ﬂﬂfrs
button (p.65) of Images
Peripheral illumination 63 F
Chromatic aberration OFF . . Chromatic aberration gy
—— Lens aberration correction (p.65 : Editing
Color blur OFF (p ) Colart JPEG/T'FF
L Distortion OFF J Distartion |mages
Reference
——— Enlargement display position* ——— Enlargement display position*

* If an image is displayed enlarged, the enlargement display position can @
be moved by dragging. The enlargement display position appears
when [Docking display] (p.81) has been set and the editimage window
(p.120) has been enlarged. 117



R

List of NR Preview Window Functions (62 p.99)
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(s BB MR Preview

Basic
Operation

Enlargement display

. Advanced
position Operation
Navigator window TE——
Advanced
Image Editing
(RAW) Image type* and Printing
Luminance noise reduction ) . .
[{m 3 5 = Lumln_ance noise Processing
Vi 5 I’eduCtlon LargeNumbers
Chrominance noise reduction 5 ) ) of Images
(o 0 - 20 Chrominance noise
i i it diiiiiinl J rduction
i © , . Editing
( Cancel ) ( Apply )_l_ Apply noise reduction JPEG/TIFF
k button Images
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NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.



List of Quick Check Window Functions .16 p.18)

50% view/100% view (moiré reduction off)/full view*'

Check marks (p.18)

File name of image

808 2/15 IMG_0002.CR2 [3456 x 2304]

Check mark display —
Rating mark display

[ 50%\|iiew f{ Full screen }—

Check mark

MY s o

7 c\ea,— e

Rating

_

i Reject =

— Displaystheimage
in full screen*?

| Removes check
marks (p.18)

. Rating (p.18)

( Pre\lrious ) (

Switches between
displayed images

Next )
_ AF Point
| Image Information |
e

( Rotate left ) ( Rotate right )

Displays the AF
points (p.16)

— Displays the image
information window
(p.24)

Image rotation
(90 degree units)

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.

— Rating (Reject) (p.18)
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List of Edit Image Window Functions (p.34 r.36)

Shows/hides tool palette
Shows/hides thumbnail display area

Switches to main window
(p.112)

Image information (p.23)

Shows/hides grid*4

Enlargement ratio of displayed image

Displays the copy stamp window

Displays the trimming/
angle adjustment window
(p-38, p.100, p.122)

|

(p.69 to p.73, p.103 to p.107, p.124)
|

@ Digit{l Photo|Profess
(SHBiS)

Toolbar

Thumbnail display area*3 —| ©

gm _ woooscee

Information display*2

(1114, 1304): 113,132,172

lonal File Edit View Label Adjustment

Tools Window Help
E Digital Photjo Professional - [ ENG/Users/canon/Pictures fPhoto/xxxx_xx_xx/I1G_0003|CR2 |

= 4 ThuB:l4PM J

Image path and

vy @@ @

—( RAW | RGE = NR/Lens/ALO

file name

Batch conversion/
saving

(p.88, p.89, p.125)

| Brightniess adjustment

3]

|wma balance adjustment

5 -

Shot settings

| Picture Style

Standard

100 -8.0 60 -40 -20
Contrast:
Highlight:
Shadow:
[ Linear
Calor tone:

Color saturation:

Strength:

Unsharp mask I':!

: <[ /mage rotation
.~ | (90 degree units)
B Tune.. )

=) Switches between
- = WL—J displayed images
-—— Tool palette
(p.116)

(3 TS
@ ==
i e st
{1} ————

RAW / Adobe RGB CMYK —  High quality

Image color space*! and work color space C|MYK simulation display (p.82)

(p.73, p.82)
*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values

(8-bit conversion).

*3 Displays images selected in the main window. The image selected

here is enlarged and displayed on the right.

Display mode*>

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.80).
*> The item selected in [Viewing and saving RAW images] (p.78) of the
[Preferences] window is displayed.
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List of Convert/Save One Image Window Functions (.42

Convert and save
| File name
Save As: DPP_001 | [+]
Types of image
- n Where: [ Photo | :% Save destination
Type of image Extension
Exif-JPEG JPG File format
Exif-TIFF 8bit .TIF i i =
TIEF 16bit TIF Kind of file Exif-JPEG )
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Image quality ; —— 1 JPEG compression rate*3
TIFF 16bit+Exif-JPEG | .TIF/.JPG Gt Embeds of ICC profiles*2 (p.127)
Output resolution 350 dpi [ Embed ICC profile
Resolution*1 |
Resize setting )
| Resize
Size changing*4 Width - Height _ Unit B
3504 2336 pixel B
{ 3504 pixel ) { 2336 pixel ) —
f Lock aspect ratic
J
I'; Cancel jj ( Save )7_ Save

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.73, p.82) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.73,
p.82), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.
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List of Trimming/Angle Adjustment Window Functions (.35, p.100)

Cancels all the trimming (aspect ratio) information

8N [# 1/1 IMG_0001.CR2 [3456 x 2304] |

’ Full screen

J

( Clear ) ( Reset +
Aspect ratio
o =
L 2.4 v
3.00 = 2.00
Y
704 7] 362 8
Width Height
1577 + 1051 3

10.10

[Angle

et
'

( Rotate left )( Rotate right ) )

(( Copy

Apply All
|

J

[ Previous )k

Next

)

Opacity

! Show borders

——— Switches between displayed images*?2

Full screen display/returns to normal screen

—— Reverts to the condition when the image was shot

—— Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1

—— Upper left coordinates of trimmed range (you
can also enter numerical values)

—— Size of trimmed range (you can also enter
numerical values)

—— Angle of image adjusted
(Drag bar, use the mouse to click A/V¥ or enter
numerical values to set angle)

Y( - Paste J— Copies the trimmed range and applies (pastes)

it to another image*?

—— Applies the copied trimming range to all other
images*2

Level of opacity outside a trimmed range

—— Shows/hides grid lines
(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the

e
__ Show Grid
Grid pitch
S}
I Center on Screen } ;
( Cancel ) E oK )
L {704 ,362)-> (2281,1413) = (1577 x 1051 ) [ 1.50] %_‘

Trimming range

window

Displays borders around a trimmed range

Image rotation (90-degree increments)

“1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Qperates when you have selected multiple images and the trimming/
angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions 65

When the list box for selecting an extender is displayed in the
[Lens aberration correction] window, select the extender
attached at the time of shooting from the list box.

ra-—n —

Lens aberration correction - [IMG_0001.CR2]

Shooting distance information < ! >

Reset

O |

L]

|| Peripheral illumination
) 100

= 5
__ Chromatic aberration

To correct distortion aberration of images shot with a fisheye lens,
four effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

s

—Enlargement display section*’

| Reverts to the condition when the
image was shot

— Shooting distance information
slider*2 (p.68)

— Peripheral illumination correction

}— Chromatic aberration correction

R —[}—IE —{]—)7

— Corrects blue chromatic aberration
Color blur correction

|| Color bilur

Distortion correction

|| Distortion

Shows/hides position of

enlargement display section

\ |
Enlargement display position
(Navigator display)
*1 The area you clicked on the image (Enlargement display position) is
displayed at 200%.

aberration

Corrects red chromatic

Grid display

*2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider

indicator changes to the zoom magnification.
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List of Copy Stamp Window Functions (p.69t0p.73,

p-103 to p.107)

[# 1/2 IMG_0050.CR2 [3456 x 2304]

[ 100% view ] { Full size view_}-

— Full screen display/returns to normal screen

{ Apply Dust Delete Data q—
~

(Dark)

{ (Light
;. OO @O §

Select Copy Source =

- | Fix Copy Source position

o
Pen type
=) Brush

_ pencil

30

(U ndo Redo

(Ceow I rae
é (\ Previous } Next

NN N L NSNS E L

C o J

Set to 100% View to perform stamp operation. //

— Applies Dust Delete Data (p.69, p.103)

— Types of dust to be erased (p.71, p.105)

. Specifies the copy source (p.73, p.107)

— Fixes the copy source position (p.73, p.107)
— Types of stamps (p.73, p.107)

Sets the size of the dust erasure range (p.71,
— p.105) or copy range (p.73, p.107) in arange of

5to 100 (in one pixel units) (you can also enter
a numerical value)

— Restores/redoes the image
— Copies the dust erasure range or copy range and
applies (pastes) it to another image

— Switches between displayed images*

* Operates when you have selected multiple images and the copy
stamp window is displayed.

}
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (.s¢)

File names of images to be
batch saved

Types of image

T T,
IMG_0001.CR2

IMG_0002.CR2
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2
IMG_0006.CR2
IMG_0007.CR2
IMG_0008.CR2
IMG_0009.CR2
IMG_0010.CR2
IMG_0011.CR2
IMG_0012.CR2
IMG_0013.CR2
IMG_0014.CR2

IMG_0015.CR2
) S ————

Batch settings

Save folder
MacOsX /Users/canon/Documents

. b
' Browse... . }

- Save destination

— JPEG compression rate*3
Resolution*1

— Embeds ICC profiles*2 (p.127)

File format
#(Kind of file ' Exif-JPEG = D
Image quality i\_/I 10
Qutput setting
QOutput resolution 350 dpi W Embed ICC profile
( Resize setting )
| Resize
Width Height Unit
3456 @ x 2304
{ 3456 pixel ) (2304 pixel ) B
v
. = J
(" File name A

Type of image Extension
Exif-JPEG JPG
Exif-TIFF 8bit .TIF
TIFF 16bit .TIF

Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG

TIFF 16bit+Exif-JPEG | .TIF/.JPG

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.73, p.82) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.73,

) Current file name
String

4) New file name

String Sequence number
_DPP_ Sl e e 06-01 SIEIR e R
B3z DPP_OOOL.JPC, DPP_O0OZ. PG

\

Size changing*4

File name

| Save sequence number

4 Image transfer settings
"| Dpen image using software

Browse...

2 J

’_ Convert RAW images only \ ’ Cancel

_\ f Execute )

Batch transfer to other image
editing software (p.89)

Images to be converted are limited to RAW images*>

p.82), the ICC profiles are embedded automatically.

Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality

becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the

longer edge of an image and change its size.
*5 Appears when you click the [Batch process] button (p.112, p.120)

without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.
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List of Rename Window Functions .20

MacOSX /[ Users/canon/Pictures /Photo/ xxoo_ xx_xx

(File Name

DPP

\.

=
s

Shooting Date/Time 3 Sequence number E]

. N\
Extension

Do not change E]
vy

Sort

Order in which images are sorted

Check mark to apply the same —
name to RAW images and JPEG
images recorded simultaneously

Check mark to copy the images

-
. File Name

| ———

( Basic Sewings

f*) Fit to main window

(_ shooting Date/Time

( Formatsewings

Sequence number

Shooting Date/Time

Month Day Year

( __ Copy & Rename

) MM-DD-YY

Click the [Browse] button and set
the save destination

MacOSX/Users /canon/Desktop

E Insert underbar

\

0001 | Save sequence number

~

3
3

Original File Maodified File Name

IMG_0001.CR2 DPP_09-13-06_0001.CR2

IMG_000LJPG U DPP_09-13-06_0002JPG U
IMG_0002.CR2 DPP_09-13-06_0003.CR2

IMG_0002 JPG DPP_09-13-06_0004.JPG

IMG_0003.CR2 DPP_09-13-06_0005.CR2

IMG_0003 JPG — DPP_09-13-06_0006.JPG

IMG_0004.CR2 DPP_09-12-06_0007.CR2

IMG_0004 JPG DPP_09-12-06_0008JPG

IMG_0005.CR2 DPP_09-13-06_0009.CR2

IMG_0005 JPG .| DPP_09-13-06_0010.JPG =
[ 2 - —y . € - ) A fh

( Cancel

| Coeane )

Sets the new file name

Sets the format of information

in the file name

R
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in RpSiatel
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
TN ; ; ; Image Editing
printing industry, swtablg fpr simulation of B siabinG
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
y . .
o Rendering intent Lazgf?rﬂ:';‘é’i =
E— Adobe RGB Rendering intents are color conversion methods when printing an image.
p— %E’f’iﬁ{fgs The conversion method of each rendering intent is shown below. Editing
06 Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between LTEES
seen by the human eye colors. Even where colors slightly change, you
04 can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
02 change overall.
Relative Colorimetric : There will not be much conversion to colors
which are similar before and after conversion,
0 02 04 08 08 X but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
—— | sRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K(D65) cases where the overall tone of an image
————- ColorMatch RGB 18 5000K(D50) chapges somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and highlights change. 128
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AdJUSt JPEG IMAQgES.....ceiiiiiiiiiiiiiiieee et 92

Adjust RAW IMaAgES .. .. eeeeeeeeeeeneeeeees 25

AdJUSE TIFF IMageS......uueiiiiiiiiiiiiiiii e 92

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve AsSist)........ccoceviiiiiiiiiccnnnnnns 93
BrGNINESS ..o 94
Click White BalanCe ..........coooiiieiiiiieeeeeeeeeee e 95
CONEFAST ... 94
DynamiC RanQe......coooeiiiiiiiiiiiiiiieiii e 98
HUEB e 96
RGB Tool Palette .....oovveeiiieeieeeeeeeeeeeeeeeeeeeeeeee e 116
SaAtUratioN ... 96
SNAIPNESS ...oiiiiie e 96
Tone Curve Adjustment..........ccciiiiiiii e 97

Adjusting (RAW image)
Apply AdJuStMENts. ... 86
Automatic Adjustment (Tone Curve AsSist)........ccccoeiiiiiiiiiinnnnns 33
BrGhINESS ... 26
Brightness of Highlights............coooiiiiiii 57
Brightness of Shadows............cciiiiiii e 57
Click White BalancCe ............cccvvvveiiiiiiiiiiiiiiiiiiiiiiiiiviieeeeevveenneennens 28
Color SAturation ...........ceeeiiiiiiie e 29
(070] (ol gl =10 0] o 1=T =1 (01T 56
COlOr TONE....ueeiiei bbb abrsaasaasesssssasssasssnnes 29
Color WHEE ... 56
CONrast... .o 29
Copy AdJUSTMENTS ....oeiiiiiieiii e 86
DynamiC RanNQe......couuuuiiiii e 57
Filter Effect ... 30
MONOCAIOME ... 30
Personal White Balance ...........ccccovvvvviiiiii 87
Picture Style ... 26
Picture Style File ... 59
RAW Tool Palette..........oeieiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeee e 116
Save AdJUSIMENTS .......uvviiiiiiiiiiiiiiiiiiiiet e 86
Tone Curve Adjustment..........ccciiiiiiiie e 58
ToniNg EffeCt ... 30
TOOI Palette ....c.eeeeeeeeeeee e 116, 117

White BalanCe.........oooooiiiii e 27
Adjustment Contents (ReCIPe).........coviuiiiiiiiiiiiiice e 85, 127
AdODE RGB ... 128
Y o] o] L= 21 = TP 128
AIrange IMagES ....covvuuiiii i e e e e e e e e eeees 20, 21
Auto Lighting Optimizer .........c.ouviiiiii e 61
Automatic Adjustment (Tone Curve AsSist)....ccccccccvveeviiiiiininnl. 33, 93
Automatic Dust Erasure Processing.......ccccccvvveveevveeneenn. 69, 70, 103, 104
B
Batch Apply White Balance to Images (Personal White Balance)....... 87
Batch Change the File Name of Images.........cccccccviiiiiiiiiiiieiiie, 90
Batch Convert/Save Images (Batch Process) .........ccccoeevveeeiiiiiinneen. 88
Batch Process (Batch Save JPEG and TIFF Images)................. 88, 125
Batch Process of Multiple Images

Change File Name .........ooiiiiiii e 90

Convert/Save (Batch Process)........ccccvvvvvvvevivviiiiiieeeeeveeeeeee. 88, 125

Personal White Balance...........ccccooiiiiiiii e 87

Recipe Data ........ccooiiiiice e 85

LI = 1015 1= U RRPRR 89
Batch Settings WIindow..........coooiiiiies 88, 89, 125
Batch Transfer IMages ..........cuviiiiiiiiiiiiiiiiiiiiiiiieeeeeveeee e 89
Batch Transfer Images to Image Editing Software ...............cccoonnin. 89
Before/After Comparison Display ..............euvviiieevieirieiiieieeeeeeeeeeeeeeeeeee 53
DIt NUMDEr ... 127
BOOKMAIK ... 51
BrghINESS. ... 26, 94
C
Change File Name..........oooiiiiiiiiee e 90
Changing the File Name of Images in the Order in the Main Window. 90
Check Mark ........c.ooiiiiiie e 18, 19, 114, 119
Chromatic Aberration Correction ..o, 65
Chrominance Noise Reduction (JPEG, TIFF Images)......c.....ccccuvvveee. 99
Chrominance Noise Reduction (RAW Images) .........ccccuvveeeeeeiiiiiiinnen. 62
Click White BalanCe.........oeeeeeeeee e 28, 95
CMYK Simulation .......c.eoveiiiiiieiiiee e 82, 83, 128
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Collection WINAOW ......coeeeeeee e 6, 36, 113
Color Blur Correction .........coceeiveiiiiieeeeeee e, 65
(©70] o] g @1 o F- T SRR 128
Color Management (Color Matching).........cooocuviiieiiiie e 127
Color Setting of the Monitor (Profiles) ........ccccccevviciiiiiieeceiie 82
Color Setting of the Printer (Profiles)..........cccccciiiiiiiieen. 82, 83
COlOr SPACE......ci ittt 128
ICC ProfileS ..coooveieieeeeee . 127
Color Management (Preferences)........cccccceoviiiii, 82
Color Saturation ... 29
Color Setting of the Monitor (Profiles)................ccccccl, 82
Color Setting of the Printer (Profiles) ..., 82, 83
Color SPaCe ....ccooveiiiiiii 128
AdODE RGB ... 128
APPIE RGB ... 128
Color Space Setting for Each Image ..........cccccoviiiiiiiinieiiine 73
ColorMatch RGB .......ooiiiieeeeiee e 128
Default Setting of Color Space ..........cooccvviiiieeeiiiiee e 82
SRGB ... e a e 128
Wide Gamut RGB........coooii 128
Color Space Setting for Each Image...........coocuvviiiiiiiiiiiiiiiieeeee e 73
Color Temperature..........ccccoooeiiiiii 56
ColOr TONE .o, 29
(O] (o] YA Lo PSRRI 56
ColorMatch RGB.........ccooieiie e, 128
Compatible Cameras with the Lens Aberration Correction Function.. 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Contact Sheet Printing (Printing a Thumbnail List)............ccccceeeennes 75
[076] 011 7= 1) AUUTT TP 29, 94
Convert to JPEG or TIFF Image and Save................... 42,88, 121, 125
Convert/save One Image Window ..............cccoeeeeeeeeeeee e, 42, 121
Copy Stamp (Image Correction) ........ccceeeeeeeeiiiiiiiiiieee e 73,107
Copy Stamp Window ... 69, 71, 103, 105, 124
Copying and Pasting (Applying) ReCIipes.........ccccvvvieeeiiiiiiiiiiieeeee e 86
Correct Images (Copy Stamp Function) ............................ 73, 107
Creatinga Folder ... 50

D

Default Noise Reduction Settings...........ooovciiiiiiiiiiiiiiie 81
Default Setting of Color SpPace ..........ccvevviiiiiiiiiee e 82
Delete IMages ... ... 49
Deleting

Delete IMagesS.......ooo v 49

Delete the Software ...............ccc 111
Deleting DPP (Uninstalling) .........cccccceeiiiuiiiniiiiiiiiiiiiiiiievveevveseresveeeene. 111
Detailed Setting Printing (Printing with Shooting Information)............. 74
Display

Before/After Comparison Display..........ccccooeeeieiii 53

Enlarged Display (Edit WiNdOW) .........c.ceuviiieiiiiiiiiieeeeeeee 11, 115

Enlarged Display (Quick Check Window) ...........ccceeeveeeennnes 16, 119

Shooting Information Display .........cccccccvviivviiiiiiiniiiiiiiiiinnenns 10, 23

Single Image Display .........cooooiiiiiiiieee e 22

Synchronize Edit WINAOW ...........oveiiiiiiiiiieeee e 54

Thumbnail Display (Main Window).............cccuveeeeiiiinniiienee. 10, 112

Thumbnail Display and Enlarged Display

(Edit Image WindOoW)........ccuueiiiiiieeiiiiiieee e 34,120
Distortion COrreCtion ............eviiiiiiiii i 65
Downloading an Image to Your Computer ............ooccuviiiieeiiiiiiiiiiieeeee. 7

Downloading Images froma Camera .................cccoeeeeeee . 7

Downloading Images from a Card Reader..............ccooeciiiiveneennnnns 9
Downloading IMages ......ccuuiiiiiiiiiieeeie e 7
Downloading Images from a Camera............ccccuvvvvivvniinninnniiirinineninnnnnn, 7
Downloading Images from a Card Reader ............coccviiieiiiiiiiiiiiiiee.
Dust Delete Data ..........ccccoveiiiiiieeeeee e
Dust Erasure Processing

Automatic Dust Erasure Processing .......cccccvvvvveeiiiieieeeeeennns

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair Function) ...........ccccccvvveeeeinns
DynamiC RANGe ........c.cuuiiiiiiiiiiie e 57, 98
E
Edit Image WindOW.........cooveeviiiiiee e e e e 34,120
Edit WINAOW.......e e 11, 115
EditiNg. ..o —Adjusting
Enlarged Display (Edit WiNAOW) ........coooiiiiiiiiiiiiiiiieeceeeeeee 11, 115
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Enlarged Display (Quick Check Window) ...........ccceeeviiiiiiiiieeeeeeenes 119
EOS ULty ...t 7
F
False Color RedUCion ............oiiuiiiii e 78,79
Filter EffeCt. ... e 30
[2T0) [0 L= gAY o o [0V 2T 6, 112
G
General Settings (Preferences) ........ccccvveeeviiciiiiiiieee e 78
H
HelD. s Cover
Highlight Area Warning Indicator ...........cooooi oo 55
HUEB oot e e e e e e e e e e e e 96
|
1O O o o] 1 1= P 127
Image Frame Information (Image Marks) ..........cccveveeviiiiiieiieeeeeennenn. 114
Image Marks (Image Frame Information) ..........ccccccciiiiiiiiinniiiinnn. 114
Image Quality
Default Noise Reduction Settings...........ccccceiiiiiiiiiii 81
False Color RedUction ..........ooeeevieeeieiee e 78,79
Improve the Quality of an Image (Main Window) ...........cccceeee.... 23

Noise Reduction of a JPEG Image (Luminance, Chrominance) .. 99
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save a RAW Image .........cccooeeeeee, 78,79
Image Shooting Information Display ...........cccccceeeiiiiiiiiiiiees 10, 23
Improve the Quality of an Image (Main Window).........cccccevviviieennenn. 23
J
JPEG IMaQE.. it 127
L
Lens Aberration Correction...........ccoooooeeeiiii 63
Lens Aberration Correction Window .........c.oveeeeveeiieiieiaeees 65, 123
LN BA ... e 29
Loading and Pasting (Applying) ReCIipes .......ccccceeeiiiiiiiiiiiiians 86
Luminance Noise Reduction (JPEG, TIFF Images)........cccccccovniunnnnnn. 99
Luminance Noise Reduction (RAW IMages) .......ccccceveeeviinnnnnnnnnnnnnns 62

M
MaIN WINAOW ..o 10, 112
Manual Dust Erasure (Repair Function) ..........ccccccooeiiiiiiieeeeennnns 71,105
1Y/ o] g ToTed o1 ] o1 30
Filter EffeCt.....ceeeeeee e 30
ToniNG EffeCt. ..o 30
Move Or COPY FOIAErS ......ccooiiiiiiiiiiie e 51
Move Or COPY IMAGES ......uuvuriiieiiiiiiiiiiiiiiitirirerveerrreeresreeeeeeerereeeeeeeeeeees 50
N
Noise Reduction (JPEG or TIFF Image).......ccccceeeeeiiiiiiiiiieeeeeeeee 99
Noise Reduction (RAW IMage) ......ccoeveeiiiiiiiiiiiee e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ......... 99
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WIiNdOW ..........ccuiiiiiiiiiie e 62, 99, 118
NR/Lens/ALO Tool Palette ...........ooevveeiiiiiiiiiiee e 117
(0
Organize IMages .......ooooeeeiei s 49
Organizing IMagES .......uuviiieeeieiiiieeeee et 49
Create @ FOIAEN .......uuieii e 50
Delete IMagesS.......ooo v 49
Move or COopY FOIAErS.........uuiiiieeieiciiieeeeee e 51
Move Or COPY IMAGES ........uuiiiiiiiiiiiiiei e 50
Register Folders as Bookmarks.............ccccoviiiiiiiieiiiiiiniiiieeee 51
P
Peripheral lllumination Correction .............ccccevveevievviieieeeieeeeieeeeeeeeeeee 65
Personal White Balance ................uuuuiiieiiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeee 87
PIcture StYIE ... 26
Picture Style File...........oeiiii e 59
PreferenCes ... ..o 78
Color Management ...........oooiiiiiiiiieee e 82
General SettiNgS .......ueiiiii i 78
TOOI Palette ..o 81
VIEW Settings .....cvviiiiiiiiee e 80
Printing
Printing a Thumbnail List (Contact Sheet Printing) ............ccccc..... 75
Printing One Sheet of Paper...............ccccc e, 14, 49
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Printing Using Easy-PhotoPrint ..o 46
Printing Using Easy-PhotoPrint EX .........cccccciii 43
Printing with a High-End Canon Printer...........cccoviiiiiiiiiiiiee. 76
Printing with a Large-Format Canon Printer............cccccceeevinnnee. 77
Printing with a Printer other than Canon Printers......................... 49
Printing with Canon Inkjet Printers ..........cccccoooiviiiiiiieeeees 43, 46
Printing with Easy-PhotoPrint Pro .............cccooiiii 76
Printing with Shooting Information (Detailed Setting Printing)...... 74
Rendering Intents when Using Easy-PhotoPrint .................... 82, 83
Printing a Thumbnail List (Contact Sheet Printing) .........cccccccoviinneeen. 75
Printing One Sheet of Paper...........cccvveiiiiiiiiiii e 14, 49
Printing Using Easy-PhotoPrint............coooie 46
Printing Using Easy-PhotoPrint EX..........ccooiiiiiiiee 43
Printing with a High-End Canon Printer...........cccccoviiiiiiee 76
Printing with a Large-Format Canon Printer ............cccccoeveeiiiiinnee. 77
Printing with a Printer other than Canon Printers..............ccccceennne. 49
Printing with Canon Inkjet Printers............cccovveeeiiiiiiiiee e 43, 46
Printing with Easy-PhotoPrint Pro..........ccoooo i, 76
Printing with Shooting Information (Detailed Setting Printing) ............ 74
Q
QuUICk Check WINAOW........cuuuiiiiiee e 16, 119
QUILEING DPP ...t 14
R
RaAtING. ..o 18, 19, 119
RAW IMaQE... .o 127
RAW TOOI Palette ...........ooeiiiiiiiiiiee e 116
Re-Adjusting an Image ... 43, 108
RECIPE ... e 85, 127
ReCipe File ... 85
Re-Editing an Image ... 43, 108
Registering Folders as Bookmarks ..o 51
ReNAME WINAOW ... .o 90, 126
Rendering Intent (Matching Method) ... 128
Rendering Intents when Using Easy-PhotoPrint ................... 82, 83
Rendering Intents when Using Easy-PhotoPrint......................... 82, 83
Repair (Manual Dust Erasure) ..........ccccooiiiiiiiiiiiiicis 71,105

RGB Tool Palette..........cooviiiiiiiiiieeee e 116
Rotate Images ......ccoovvvvvivieiicii, 10, 25, 112, 113, 119, 120
S
SatUratioN ..o 96
Save
Batch Convert/Save Images (Batch Process)..........ccccc....... 88, 125
Convert to JPEG or TIFF Images and Save .........cccceeeeeeeeee. 42, 121
S AV e 41, 107
SAVE A ——— 41, 107
Save JPEG or TIFF Image as a Separate Image ..........cc........... 108
View and Save RAW IMages.......cccccvvvveeiiiiiiiiiiieee e 78,79
S AV AS e 41, 107
SaViNg RECIPES ... 86
SeleCt IMages......cooooieiie s 10, 16, 34
Shadow Area Warning Indicator............ccccooiiiiiiiiiiiiiis 55
SNAIPNESS ...t 31, 96
Shooting Information Display..............ccccciii, 10, 23
SHOMCUL KEYS ... Cover
Single Image Display ..., 22
Single Image Display of RAW and JPEG Image............ccccceeivviinnnen. 22
Sorting Images
CheCK Marks ......oeeeiiiie e 18, 19
RaAtiNgS .o 18, 19
SRGB ... e e e e e e e e e e 128
Starting UP DPP ... 6
Supported IMages ..., 3
Synchronization (Edit WindOW)............coooiiiieeee e 54
Synchronize Edit WIiNdOWS ..o, 54
SYNCroNiZe IMAgES .......uuiiiiiiiiiiiiiee e 54
System Requirements ...............cc . 3
T
Thumbnail Display (Main WindOW) .........cccooviiiiiieenieeiiiieeeeen 10, 112
Change the Display..........cccccuuiuuiiiiiiiiiiiiiiiieiiieeieereeeeeeeeree e 10
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 34
Thumbnail Display of Images (Main Window) .............ccooccviiieeeeeninnnes 10
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Change the Display .........ccooiiiiiiiiiie e 10
TIFF IMAGE ... 127
TONE CUMVE ...t e e e e e e s 127
Tone Curve Adjustment ..........oooviiiiiiiiiiiiiieeeeeee e 58, 97
Tone Curve Assist (Automatic Adjustment) ..........ccccceeeiin. 33,93
ToniNg EffeCt.....eeeeeeeeee 30
Tool Palette

NR/Lens/ALO Tool Palette ..........coovvevieeiiiiiiiiiiiiiiiieeeee 117

RAW ToOl Palette.........coieiiiiiecee e 116

RGB Tool Palette .....oovvveiiieeiieeeeeeeeeeeeeeeeeeeeeeeeee e 116
Tool Palette (Preferences).......vvveeiiiiiiiiiiiiiiiee 81
Transfer

Batch Transfer Images to Image Editing Software...................... 89

Transfer an Image to PhotoShop....... ... 73
Transfer an Image to Photoshop .........ccccoveeiiiiiiii e 73
Trimming and Adjusting the Angle of an Image........................... 38, 100
Trimming/Angle Adjustment Window .............cccccovviieeennnnns 38, 100, 122
U
L L F g F= T o 1 = T 32
\'

View Settings (Preferences) ... 80
w
White BalanCe.......c..ooviviiiiiiieiieieee e 27

Click White BalanCe .......ccouoveeeeeeeeeeeeeeee e 28, 95

(070] (ol gl =10 0] o 1=T =1 (0 [T 56

(O70] o] T4 L= SRR 56

Personal White Balance ... 87
Wide Gamut RGB ..........oeiiiiiiiiiiieeeeeeeee ettt 128
WOrK COlOr SPACE......uuuuuiiuiiiiiiiiiiiitiiitiitttirserrersrssressreesrerrrererrereeer————— 73

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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